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C l a s s i c  I X g e n
Preface 
(All page numbers and cross-references are active links when this 
document is viewed in an electronic format. Click the link to go the 
area of interest.)

Overview of this Guide
This table provides a high-level summation of the information in this guide:

Table 1 Summary of IXgen Documentation 

General Topic Brief Description Page

IXgen Overview and 
Introduction

Provides a general introduction to IXgen, 
including license acquisition.

page 21

Installing IXgen (Quick) Quick overview/refresher of installing IXgen page 11

Installing IXgen (Detailed) In-depth look at installation details; includes 
sample screen shots. This appendix is a near 
duplication of the “IXgen Central” page of 
http://www.fsatools.com

page 103

Installing IXgen by Hand If your automated installation is not successful, 
installing IXgen by hand can help identify (and 
correct) any installation problems. 

page 99

Installing IXgen with 
FM+SGML

While not an officially supported combination, 
many users are using IXgen with FM+SGML. 
Special considerations apply, however.

page 102

General Tool Notes Provides overview and general information about 
the various IXgen tools.

page 19

Reference Information Each IXgen tool is described in detail. page 26
Preface www.fsatools.com 9
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Overview of this Guide Preface
Conventions used in this Manual
System items, such as file or folder names, are indicated with a typewriter font.
IXgen tool names are shown in bold font and are hot linked in the PDF version of this document. 
Click the bolded tool name to go to the explanation section for that tool.
“Windows” refers to all 32-bit Windows, including but not limited to 95, 98, 2000, NT, ME, and 
XP.

PDF and Document Layout
The font styles and sizes used have been optimized for PDF. (On a 1024x768 display, PDF view 
clarity is usually best at 100%. 125% can be better on a 1280x1024 display. Your monitor and 
video system may provide better results at other settings.) The pages and running headers and 
footers are set up “book style” for two-sided printing and binding of this document. While most 
cross-references are “hot links” in PDF, we’ve also included many page number references, which 
will be useful if you print your own paper copy.

“Cookbook” Items A number of step-by-step procedures show how 
IXgen can perform a number of “real-world” 
indexing and marker generation tasks.

page 78

Problems and Solutions Several common problems are listed, including 
one or more solutions for each problem

page 85

Table 1 Summary of IXgen Documentation (Continued)

General Topic Brief Description Page
10 www.fsatools.com 160301 IXgen 7 & 7-10 (for FrameMaker 7 through 15)
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Overview Assumptions and Set-up Notes
Assumptions and Set-up Notes
Table 2 lists general IXgen attributes. You are assumed to have a basic familiarity with Windows 
and with FrameMaker. 

Table 2 IXgen Set-up Notes 

Topic Notes

No user-controlled installation configuration is necessary for Windows 
IXgen. Such configuration is handled by the Windows installer.

IXgen requires a license. A “license” is an administrative concept, 
while passwords activate IXgen and are issued by us against the 
license you own (or borrow for demonstration purposes).
You will need to enter a password obtained from us, usually via email 
to franks@fsatools.com. (Specific password acquisition 
instructions follow next.)
Password installation instructions are in the “IXgen Central” page of 
the fsatools.com website, as well as in this manual also with each 
password we email to you.

If you plan to upgrade to FrameMaker and have an IXgen license for 
an older version of FrameMaker, you will need a new IXgen 
distribution and password from us. Distributions can be downloaded 
from the “IXgen Central” portion of http://www.fsatools.com.

PC running 32 or 64-bit Windows (2000, NT, ME, XP, Vista, Windows 
7, 8, 10 and their derivatives), tuned for FrameMaker operation. Your 
system will need adequate memory and adequate virtual memory — 
the “ideal” amount will depend on which operating system you are 
using, how it is set up, and the nature of the documents you produce 
(graphics-intensive documents will often require more physical 
memory for reasonable performance). IXgen itself generally has a very 
small impact on system memory requirements.

IXgen itself (including this document) requires approximately 5 
Mbytes of disk space. Source FrameMaker documents processed by 
IXgen remain approximately the same size as the originals, plus any 
additional space required by IXgen-added markers.

Installing IXgen

Overview
The “IXgen Central” page of http://www.fsatools.com describes these complete steps:

Configuring 
IXgen

General 
Licensing 
Notes

FrameMaker 
Upgrades

General 
System 
Requirements

Disk Usage
160301 IXgen 7 & 7-10 (for FrameMaker 7 through 15) www.fsatools.com 11
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Installing IXgen Preface
1. Downloading

2. Installation

3. Licensing

4. Applying the IXgen password.

“IXgen Central” is the recommended documentation resource for detailed instructions, including 
example screen shots of the above steps. (Or, you can jump right in and try the Installation Quick 
Start, which follows in the next section.)

If you do not have a consistent or reliable internet connection, the web pages for the above steps 
are included in Appendix B: IXgen Installation Pages from www.fsatools.com starting on page 103. 
You will, however eventually need a connectioin for downloading IXgen components and 
communicating licensing information with us.

If you have difficulties installing IXgen, please review Appendix A: Installing IXgen By Hand 
starting on page 99. This appendix describes the nuts and bolts of an IXgen installation. Use this 
information to troubleshoot your installation. If you are still having problems, please contact us.

CAUTION: If you are using FrameMaker 10 or newer versions and your book or 
document contains unicode characters, do not use any IXgen functions in 
that book or document. For more information see Damage to Unicode 
Characters in FrameMaker 10 (and newer) starting on page 15.

Installation Quick Start
If you have installed IXgen before, or have installed a lot of applications over the years, these 
quick steps might be all you need. If you do need clarification, please go to Appendix B: IXgen 
Installation Pages from www.fsatools.com starting on page 103 for more details, including sample 
screen shots. (Or, you can review the “IXgen Central” page of http://www.fsatools.com 
for the same information.)

Otherwise, here are the quick steps:

1. Quit FrameMaker if it is currently running.

2. Download the appropriate IXgen distribution from the download tab of the “IXgen 
Central” page of http://www.fsatools.com. Save the download into a new 
folder. Saving to the Desktop or general temporary folder is not recommended.

3. Double-click on the distribution to self-extract. If the extraction won’t start, you can also 
try right-clicking and selecting “Run as Administrator”.

4. Among the extacted files, right-click on setup.exe and select “Run as Administrator”. 
Review the information screens presented as the installer progresses. Most users will be 
able to press Enter at each prompt.

5. Press Enter on the final screen to exit Setup.exe. (A complete exit of the installer is 
required. The installer window should no longer be active when you go to the next step.)
12 www.fsatools.com 160301 IXgen 7 & 7-10 (for FrameMaker 7 through 15)
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Installation Quick Start Removing or Disabling IXgen
6. Right-click on framemaker.exe in your FrameMaker main folder and select “Run as 
Administrator. “IXgen” should now appear in the FrameMaker main menu list.

7. Select IXgen>License. Copy the complete contents of the System Key field on to the 
system clip board (Control-C). Email us at franks@fsatools.com. Be sure to put IXGEN 
somewhere in the subject line of your email. In the body of the message include your 
name, organization, telephone, preferred email, and whether you are a contractor or 
regular employee. Paste (control-V) the system key into your message.

8. When you receive your password from us (typically less than eight business hours after 
you send your email to us), again start FrameMaker while “Running as Administrator.” 

9. Select IXgen>License. Copy the password string from the email you receieved from us 
and paste it into the “Current Password” field. (Be sure to overwrite or remove the old 
contents of the Current Password field.)

10. Click “Update Password”. Before dismissing the dialog, check the “Password Status” 
line (second from the top). A valid password should be indicated.

If you have any questions, please review Appendix B: IXgen Installation Pages from 
www.fsatools.com starting on page 103. If you need additional help review Problems and Solutions 
starting on page 85 of this manual, or review the “Troubleshooting” page of 
http://www.fsatools.com. Please do contact us if you are unable to resolve the issue. If 
you need verify an IXgen installation or perform an installation by hand, review Appendix A: 
Installing IXgen By Hand starting on page 99.

Removing or Disabling IXgen
You can stop IXgen from loading by commenting out the API load command in the maker.ini file. 
Or, you can run removeix.exe.
To disable but not remove IXgen, follow these steps:

1. If currently running, stop FrameMaker.

2. Use Windows Explorer to browse where FrameMaker is installed. Using a plain text 
editor such as Notepad, open maker.ini.

3. Perform a search for this string: IXgen=Standard,Marker Management. (You 
will see a longer line; but the above is more than enough to find the proper line of text.

4. Insert a semicolon at the head of the line. Now this first portion of the line looks like 
this:

;IXgen=Standard,Marker Management

The next time FrameMaker starts, IXgen will not be loaded. To re-enable IXgen, follow the steps 
above but remove the semicolon from the API registration line.
To remove IXgen, follow these steps:

1. If currently running, stop FrameMaker.
160301 IXgen 7 & 7-10 (for FrameMaker 7 through 15) www.fsatools.com 13
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Using the demoixgn Demonstration File Preface
2. Point Windows explorer at <FM_install_folder>\ixgen\removeix.exe 
(double-click on removeix.exe). If the script will not execute, try right-clicking on 
removeix.exe and “run as administrator. If you are unable to run the script, you can 
manually remove IXgen by reversing the steps presented in Appendix A: Installing IXgen 
By Hand starting on page 99

3. Some operating systems may leave the IXgen folders behind. Within the main 
FrameMaker installation directly, simply delete the ixgen folder and all its contents.

Using the demoixgn Demonstration File
The IXgen distribution includes demoixgn.pdf. Note that because demoixgn is self-guided, 
do not expect a scripted or “canned” product walk through. This means you can freely try an IXgen 
function on any of your own test files, then come back to demoixgn as you’d like. If you’re 
going to experiment on your own working files, make back-up copies first. As a practical matter, 
the demonstration files referenced in demoixgn refer to the samples provided with FrameMaker 
7 and won’t match the sample file sets in other versions of FrameMaker. Guiding information is 
provided so that you can perform similar operations on your own sample files.

IXgen Interaction with Document Files

Marker Subsystem
IXgen does not change the operation of the marker subsystem in any way. IXgen is simply a new 
and improved interface to the marker subsystem. For this reason, you can freely open documents 
where IXgen has been an marker editing aid on other systems where IXgen is not installed, and 
vice versa.

Passthrough Markers
Sometimes marker text includes special command sequences that will be used by other applications 
outside of FrameMaker. (HTML or special help-system commands are two examples.) Depending 
on the syntax, some of these command sequences can be processed by IXgen, causing problems 
both for IXgen and later, the application that was to use these sequences.
Such markers are not used for indexing, but it can still be useful to edit these markers using the 
various IXgen tools — but you’ll want to stop any command interpretation that IXgen might 
attempt. 
You can identify such marker types by name and list them with the 
PassthroughMarkerTypes= parameter in the ixgen.ini file (located in the ixgen folder 
of your FrameMaker installation folder). Multiple marker names can be added to this parameter, 
separated by commas. The comments in the ixgen.ini file for this parameter will show the 
proper syntax for this feature. (Generally, this is a specialized use of FrameMaker that won’t affect 
most IXgen users.)
14 www.fsatools.com 160301 IXgen 7 & 7-10 (for FrameMaker 7 through 15)
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Reference Page Use IXgen Interaction with Document Files
Reference Page Use
While IXgen changes nothing operationally in the files it processes (other than marker content), a 
number of items are added to new reference pages within the processed files. 

CAUTION: You may look at these reference pages if you wish, but please do not alter 
the content. If you do, IXgen will fail when you attempt to use IXgen. This 
might corrupt your document. You can, however, completely remove the 
IXgen references pages if you wish, though these pages will be recreated the 
next time you use IXgen on the file.

Each of these new reference pages includes one or more text frames to hold IXgen status 
information. If you are selecting a “frame above/below” in the Advanced Properties tab of the 
Paragraph designer, you will see one or more IXgen frames listed. Simply ignore the IXgen frames, 
and select from your regular frame list.

Shadow Book File
When working with books, IXgen creates a “parallel” or “shadow” file (your book name with the 
file extension “.ixc”). Default file selection information is stored in this file. If you move a book 
file and its components to a new folder and plan to use IXgen again, it’s simplest to delete this 
file. A new file will be created when you use the IXgen Select Files command from the book 
menu. However, you may find that some defaults are not as expected. After your first pass through 
IXgen with the files in the new location, your various IXgen preferences will be stored in the new 
.ixc file.

Text Insets
FrameMaker offers a method of importing text from another document and placing that text in the 
body of the current document. These “text insets” are useful when the same text is used in more 
than one place. Maintenance changes can be made in one place — the source document for the 
text inset — and thus your changes are reflected into all document using that text inset.
Source files for text insets can contain all regular FrameMaker document components, including 
markers. However, at the inset point the text is “read only” and cannot be edited. For this reason, 
IXgen does not collect markers found in text insets.
If you wish, use IXgen on the source document of the inset. If you have many source documents 
used for text insets, make a FrameMaker book to organizer you r insets. Then, you will have a 
central and convenient tool for managing the source documents for your text insets, including using 
IXgen on those documents.

The Marker Window
Under certain conditions the work of IXgen can overwrite work done with the marker window. The 
reverse is also true. For more information see Conflicts with the Marker Window on page 26.

Damage to Unicode Characters in FrameMaker 10 (and newer)
Since its inception, IXgen has not supported Unicode (characters defined by two or more bytes). 
In past versions of FrameMaker, this caused no harm. IXgen (as hosted by FrameMaker) attempted 
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to process the extended character set, but most IXgen functions simply did not return expected 
results.
In FrameMaker 10 and newer versions, however, this has changed. Internal representations of 
Unicode characters used by IXgen DESTRUCTIVELY CONVERT the multi-byte Unicode 
character to a single byte character. Such multibyte characters are converted to a question mark 
(“?”) character when read by IXgen. The original multibyte representation is lost and cannot be 
recovered.

CAUTION: If your FM10 (or newer version) book or document contains unicode 
characters, do not use any IXgen functions in that book or document.

Generally, Western European languages that include diacritic marks, such as accents, umlauts, and 
so on, are still single-byte characters in most character sets, and are thus not affected. 
IF YOU ARE UNSURE, ALWAYS BACK-UP YOUR WORK BEFORE USING IXGEN! By 
using IXgen you acknowledge the risk to Unicode characters.

IXgen System Interaction

FrameMaker Interaction
IXgen is an API client, which means that once IXgen is properly installed, IXgen becomes a part 
of FrameMaker. Thus, the look, feel, and operation of IXgen will be similar to any other 
FrameMaker function you use. Please review the remainder of this document for information on 
each IXgen function. (Tool descriptions start on page 26.) 

Multiple IXgen Versions on One FrameMaker
While you can have the files sets for different IXgen versions on a single FrameMaker installation, 
only one IXgen will be active. This will be the first IXgen registered in the APICLIENTS section 
of maker.ini file. It is best, however (and strongly recommended), to remove the registration 
line of the IXgen version not in use, or place a semicolon at the head of that line to comment out 
that unused IXgen registration.

Operating System Interaction
Because IXgen becomes part of FrameMaker, nearly all operating system interactions, such as 
opening and closing files, calling up windowing system services, and so on, are done through 
FrameMaker. Windows users should be aware that the printer driver selection can have an effect 
on IXgen. Refer to the section Windows Print System Interaction below for a discussion.

Using the FrameMaker Console Window
IXgen writes status and error information directly to the FrameMaker console window. This is 
done to better track the activities of IXgen, which by some definitions could be considered “batch” 
in nature. IXgen is more “batch-like” than most activities inside FrameMaker.
While using IXgen for the first few times, review the console window periodically to see what 
types of information IXgen sends to this window. (Reports include the number of markers found 
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and processed, the number of markers generated, and so on. Some information is duplicated within 
the various IXgen dialog boxes, but the console window often contains more detail, depending on 
the function or type of message.)

The IXgen information recorded in the console window can be invaluable when backtracking the 
activities of an IXgen session.

Windows Print System Interaction
One area of concern for any Windows user with any application (not just FrameMaker and IXgen) 
is the sometimes “over-coupling” of the printer driver to the application. This means that an 
inappropriate printer driver, once connected to FrameMaker, can produce bizarre displays, even to 
the point of effectively crippling FrameMaker. Even with mitigators, such as Adobe Type Manager, 
this can still be a problem.

Perhaps realizing a less than ideal operating system design, in current versions of Windows the 
system will “help” you by reformatting the document to the fonts available in the printer driver 
currently connected. This can be done in such a way that you’re never completely warned, and 
your desired formatting is effectively ruined. We find this operating system design difficult to 
defend, but unfortunately, we have no control over the current situation.

Because IXgen becomes a part of FrameMaker when loaded, IXgen and its templates are 
susceptible to any printer driver or font problems you might have.

If you have any appearance problems with IXgen or FrameMaker, or if any IXgen function fails, 
check to be sure the correct printer driver is in use, and that the driver is not corrupt. We have 
found that under unknown circumstances, Windows printer drivers can become damaged and thus 
need to be reinstalled. This is best done by deleting the printer in question from the printer setup 
list, then reinstalling the printer driver. (Consult your Windows documentation or help files.)

The IXgen templates use fonts common to most systems. However, you may still have display 
problems or be unable to use some IXgen functions because the fonts used are not in your current 
printer driver. If this is the case, you can change the font portions of demoixgn.fm and the 
various IXgen templates. This is discussed next.

Changing the Fonts Used by IXgen
The IXgen templates use common fonts. However, Windows users can still have display problems 
or IXgen operations might fail because the printer driver you use does not support these fonts, or 
does not support a full range of sizes. Windows users may wish to use a display font better suited 
to their environment. Follow these steps to change fonts:

1. Templates used by IXgen for FrameMaker are in: 
<FM_install_folder>\ixgen\templates. Open each file with FrameMaker.

2. Access the Character Designer (control-D). Make sure that no named character tag is 
showing (the Character Tag scroll box should be empty), and that all the fields are set to 
“as is”. Use Commands>Set Window to As Is to do this.

3. Select the desired font family that looks best on your display — leave the other fields 
set to “as is”. 
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4. Use Commands>Global Update Options. Set to “All Characters and Catalog Entries”, 
then click UPDATE.

5. Save and close the template document, then repeat the above steps for each file in the 
template folder.

You need only do this operation once; fonts do not need to be updated on a regular basis unless 
you have switched to a printer driver which does not support your current font selections.

You are welcome to change font usage in any IXgen template so that IXgen looks as you want it 
to look with your configuration. When working with the templates, be careful not to change 
attributes other than those in the Font portion of the Paragraph designer.

Adobe User Profiles
With FrameMaker 7.0, Adobe introduced the concept of a “user profile” supplemental maker.ini 
file. The location of this file varies dependent on the operating system used. (Refer to the 
comments at the beginning of the maker.ini file for locations.)

API client registration, such as that required to load IXgen, is supposedly a blend of registrations 
found in both the maker.ini file located here, and in the maker.ini file located where you have 
installed FrameMaker 7.

So far, this has not proven to be a reliable system, and thus you will find the IXgen API registered 
only in the main maker.ini file located in the folder where you installed FrameMaker.

If you wish to make use of the user profile system, delete the following line from the main 
maker.ini and move it to the appropriate maker.ini file in the User Profile section:

 IXgen=Standard,Marker Management,ixgen\bin\ixgen.dll, all

Error Reporting

Errors During FrameMaker Startup
The first time you restart FrameMaker after installing IXgen, you may want to monitor the starting 
status of IXgen in the console window. Status text indicates the state of the FrameMaker start-up, 
and its connection to IXgen. You can assume a successful IXgen start-up if you that “IXgen” 
appears in the main menu bar of FrameMaker. Otherwise, be sure to review Problems and 
Solutions starting on page 85. Your problem might be listed there. You can also review the FAQ 
portion of http://www.fsatools.com, or call us at 1-435-275-8981 (this number does not 
accept text messages).

Errors During Use
IXgen may occasionally encounter some difficulty. One or more pop-ups will describe the problem 
and recommend a solution where possible. In addition, always check the console window for 
additional details on any errors encountered. Be sure to review Problems and Solutions starting on 
page 85. Your problem might be listed there.

If you experience any other type of difficulty, please contact us.
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System or FrameMaker Errors
In recent years operating system stability has improved. However, crashes still occur. We urge you 
to make frequent saves and temporary back-up “snapshots” of your work as you go. This is a good 
recommendation especially when working in Windows, no matter the application.
When working with the IXgen tool Gen Editable Marker List across a book, a large number of 
markers can be collected. You may be investing much time editing those markers before applying 
them, so be sure to occasionally save the editable marker list as you work. This way, should a 
system or FrameMaker crash occur, you can continue from where you left off. (Normally, such 
saves are not typically required as the editable marker list is a temporary document. But as your 
editing time grows on this document, consider occasionally saving the work.)
When working with a large number of markers, you may also want to occasionally apply all work 
done with the Gen Editable Marker List tool back to the source files. Once applied, discard the 
current editable marker list then generate a fresh copy (use Gen Editable Marker List again) and 
continue.

CAUTION: Refer to the caution on page 33 regarding how a FrameMaker bug can cause 
problems with Apply Edited Marker List.. To summarize that caution here, 
do not edit or change your documents when an Gen Editable Marker List is 
active. Use Apply Edited Marker List to save your marker edits before making 
any source-document edits — no matter how small.

Configuration of IXgen Tools
Configuration of IXgen tools is done “on demand”. That is, configuration items, such as which tags 
or files to process and which marker type to work with, appear as changeable items in most of the 
IXgen tool dialog boxes. IXgen is thus readily adjusted for each tool use.
In most cases you probably won’t need to change configuration items once they‘ve been set the first 
time through. IXgen assumes the last-used configuration as the current default. 
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Reference List — Default Marker Types
By default, IXgen processes Index markers, but you can process any of the types listed in Table 3.

Table 3 List of Marker Types 

Marker Type Name Contents

Header/Footer $1 Header/footer marker #1

Header/Footer $2 Header/footer marker #2

Index Index marker

Comment Comment marker

Subject Subject marker

Author Author marker

Glossary Glossary marker

Equation Equation marker

Hypertext Hypertext marker

X-Ref X-ref (cross reference) marker

Conditional text Conditional text marker

Edit... Bring up the Edit Customer Marker Type dialog box for 
creating User-defined markers.

CAUTION: While IXgen will process the markers noted in the gray rows (HyperText, X-
Ref, and Conditional Text), modifying these markers through IXgen is not 
recommended. If you modify these markers using IXgen (or manually 
through the marker window, for that matter), hypertext linking, cross-
referencing, or conditional text settings may not work as expected, or the 
document may become unusable. Modification of these markers is best left 
to the FrameMaker functions that use them.

Some uses of hypertext markers can be considered exempt from this caution. For examples, review 
Generating HyperText Pop-ups on page 81 and Generating HyperText Links to other Documents 
on page 82.
IXgen will work with any custom markers you establish. Be sure to define any new marker type(s) 
required before using IXgen. Do so using the Edit... option in the Marker Type scroll box from the 
Special>Marker dialog box. IXgen will then be able to access and create any markers for the 
marker type(s) you define.
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IXgen Overview and Introduction

Why Index?
This question has been asked with increasing frequency in recent years, as people have 
become resigned to (or numbed by) the poor performance of flat search engines, both 
inside application help systems and on the world wide web. Poor performance there seems 
to cause lowered expectations for print (and by extension, PDF) indexes.
But given the density and volume of information we wade through daily from all sources, 
now, more than ever, we need human-designed locators into that information.
At the heart of any such system is the thought put into designing locators for the oceans 
of information we’ve created. Such thinking is often best done by people who know the 
subject matter (and how others might approach that subject when looking for 
information), and who know how to see the “big picture”, the “little pictures”, and all the 
threads running through each.
This is the work done by the indexer. A well-crafted index is a huge value-addition for 
any volume of information. Your audience can now quickly find the information they 
need; or perhaps even think of new ways to apply your information based on what they 
might see in your good index.
Enriched by using a good index, your audience has higher overall satisfaction with your 
information, does better work, and has good thoughts about you and your products. 
Contrast this to the resigned “oh, I could never find what I needed in that [book, website, 
online help]; so I’ll not be going back there or making endorsements...”
The task of the indexer can be enormous; that’s why mechanical aspects of index creation 
should intrude and distract as little as possible.
In the FrameMaker world, this is where IXgen comes in.
IXgen provides quick and easy methods to generate and maintain markers in FrameMaker, 
which means easy maintenance of indexes and other types of lists generated from 
markers.
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Concordance vs. Index
Indexing, in its most pure form, is an art. Creating a good index takes practice, typically 
several iterations, and a broad knowledge of the subject matter.

Most machine-derived indexes (and many human-prepared indexes) are not really indexes 
but concordances. A concordance is nothing more than an unedited, alphabetical list of 
keywords found in a document. Generally, the keywords are derived from the content 
itself, thus leaving out any helpful locator verbiage that might not even be in the text. 
And a search engine isn’t any better, being really nothing more than an “at the moment, 
for this keyword” concordance builder.

An index, on the other hand, provides not only a keyword lists, but also synonyms, phrase 
permutations, threading where appropriate, and cross-referencing within the index itself.

Redundant or essentially valueless occurrences of a keyword are not included in the 
index. (Contrast this with the fully automatic concordance generation in its various forms 
that we see today. Your audience wastes much time chasing references to a keyword 
where the reference is of no real value — the keyword just incidentally appeared 
somewhere in your information. No human judgement checked the validity of the 
resulting keyword “hits”.)

A streamlined concordance can have some value, but as the information being indexed 
becomes more voluminous and complex, the value of the concordance steadily goes down. 
A true index is of far greater value.

IXgen’s maintenance utilities are well-suited for index creation, from the simple to the 
complex. In fact, because IXgen makes the mechanics of marker maintenance so much 
easier, creating a true index (which often requires much hard “brain work”) will be 
feasible where perhaps only a concordance was practical before.

IXgen’s automatic marker generation features are best classified as “concordance 
enhancers”. But while working in this mode we hope that the ease with which IXgen 
handles markers will inspire more true indexing from IXgen users. IXgen makes keyword 
gathering and permuting extremely easy; then, editing and polishing the entries with 
IXgen (either in context or in a sorted list) makes the editing process simple.

How IXgen Works
While IXgen was intended for index creation and maintenance, many IXgen tools are 
perfectly suited for work with other types of FrameMaker markers such as subject 
indexes, author indexes, user-defined lists, and so on. IXgen can even help with hypertext 
markers.

VERY IMPORTANT NOTE:

Please understand that IXgen does not change the structure of a FrameMaker document. 
Documents processed by IXgen are always completely compatible with other FrameMaker 
documents because IXgen uses the existing FrameMaker marker system. IXgen merely 
provides a convenient and powerful interface to the standard FrameMaker marker system. 
Documents processed with IXgen can always be opened by FrameMaker, whether IXgen 
is present or not.
22 www.fsatools.com 160301 IXgen 7 & 7-10 (for FrameMaker 7 through 15)

www.fsatools.com
www.fsatools.com


Introduction Using IXgen Tools
Also understand that IXgen does not replace the normal marker housekeeping functions 
provided by FrameMaker. These functions include generating the final index document (or 
marker list), formatting those documents, and so on.
Said another way, IXgen provides new ways to create and edit markers; IXgen does not 
duplicate the marker collection and marker list document generation facilities already 
provided by FrameMaker.
If you are new to FrameMaker and how basic FrameMaker indexing works, we suggest 
reviewing the chapter on indexing provided in the FrameMaker manual. This will give 
you an overall idea of how markers and the marker collection process works in 
FrameMaker. You will also then better understand how IXgen can be of great aid in 
creating and working with marker text.

Using IXgen Tools

Introduction
Most IXgen tools are accessed through the main FrameMaker menu bar under “IXgen.” 
You can also access the “editable marker list” tools through the floating Editable List 
Toolbar.
As a demonstration, open a new or existing file with FrameMaker. Assuming IXgen is 
properly installed, “IXgen” should appear in the FrameMaker main menu bar.
Click and hold on IXgen in the main menu bar. The pull-down menu lists the IXgen tools. 
Some of the tools, including, for example, Permute Markers and Split multiple index 
entries into separate markers, are not available from the main menu bar (other than as 
an information item). Instead, these tools are options when the Apply Edited Marker List 
tool is activated.
Several tools work only on the document created by the Gen Editable Marker List 
operation. Capitalization, Create Subentries, Elevate Unique Subentries, Flip Entries, 
Validate References, Show Marker Char Tags Applied and Show Marker Char Tags as 
Text Cmds do not work directly with your source or IX document, but only on the 
temporary work document created by Gen Editable Marker List. 
Using an IXgen tool is just like using any other FrameMaker function. Select the desired 
IXgen tool; make sure the initial dialog is set as desired (if a setup dialog appears), then 
click the appropriate actuation button given in the dialog.
Each IXgen tool is described in the remainder of this chapter. The IXgen functions are 
listed in The IXgen Tool Set starting on page 26.

Operational Scope of IXgen Tools
You can make IXgen affect a specific amount of text by using a text selection 
(highlighting). IXgen can:

• Operate globally on a book and the document files in it. You can select which 
documents in a book are to be processed and which are to be left alone. Generated 
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documents, such as TOC, LOF, LOT, IX, and so on, are typically excluded from 
IXgen processing.

• Operate on the entirety of a single document.
• Operate only on a selected area of text within a single file. Once a portion of text 

has been selected, choose the desired tool from the IXgen pull-down menu. 
Within the working area, most IXgen tools let you to work on one or several different 
marker types at the same time, though typically you’ll work on Index markers.
Some of the IXgen functions performed in the editable marker list work best with the 
presence or absence of a selection of rows of marker text. IXgen will remind you when 
less-than-ideal selection is in place (or not in place).
Using Apply Edited Marker List is described starting on page 37.

Using IXgen Tools with Book Files

Menu Changes
IXgen can process single documents, and IXgen can also perform its work on the files in 
a book. (You choose which members of the book will be processed.)
The IXgen pull-down menu changes based on which type of file is active when the IXgen 
menu is accessed. The “Select Files” and “Open Selected Files” menu items appear when 
a book is the active document. Using these new IXgen commands for books, you choose 
which documents in the book should be processed (or ignored) when an IXgen function 
is called.
Editable marker list functions are not active in the IXgen menu when a book file is the 
active document, but will reactivate when an editable marker list is the active document. 
The contents of the editable marker list will be the markers collected from member files 
of the book that was active when you started the Gen Editable Marker List process.

Generated File Relevance with IXgen Processing
In most cases, IXgen processing is not relevant to the table of contents, list of figures, 
list of tables, front or back matter documents, or the index (“IX”) document itself. You’ll 
rarely find index markers in these documents. 
In these cases, you’ll reduce processing time by deselecting these and any other 
documents that don’t have markers in them. (By default, IXgen excludes FrameMaker 
generated files but you can add them back in if you need to. You can also deselect 
documents in the “Select Files” dialog box.)
Once established, the list of selected documents remains unchanged until you decide to 
make new selections. The IXgen defaults for book processing are stored in a file that is 
the name of the book, but with an “.ixc” extension.

IXgen Tools that Rely on Book Processing
Book file selections are very important to some IXgen tools. For example, Validate 
References requires that all markers present in the book be collected so that a valid 
search for each reference can take place. Similarly, Create Subentries relies on the 
presence of all markers in the book so that entries can be properly judged for placement 
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under a common root. Elevate Unique Subentries might be misused if you believe one 
particular subentry was unique and could elevated, when in fact another such root entry 
existed in the markers from a document in the book excluded from IXgen processing.
These specific tool comments will make more sense once you become familiar with these 
tools.

Sample Book File Selection For IXgen Processing
Here is a sample IXgen “Select Files” dialog box for the “Ecology” book included in the 
<FrameMaker7_install>\samples\overview\book folder. Note that the 
generated documents (toc and IX) have not been selected: 

“Open Selected Files” opens the “process files” and places them minimized on the 
FrameMaker desktop.
This is the preferred method of working with IXgen tools through the book menu. (The 
“Open Selected Files” button is the same as the “Open Files” option on the book file 
version of the IXgen menu. It is provided here as a convenience.)

NOTE: If you have a large number of regular documents in your book that are not 
selected, and you want to quickly select them, go the folder where the 
current book is stored. Delete the <name_of_book>.ixc file. This will 
force IXgen to use a default of selecting all regular documents listed in the 
book. (Generated documents are excluded in this default setting.) The .ixc 
file will be rewritten by IXgen.

Process Status
When an IXgen tool is selected and after its completion, results are given in the 
FrameMaker Console Window: Given the “semi-batch” nature of most IXgen tools, the 
console window is an excellent way to track your overall activities with IXgen. Perhaps 
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you’ve ignored or even closed the console window in the past, but we strongly 
recommend keeping the console window available when using IXgen. At a glance you’ll 
be able to see a history of what you’ve done in this session.

Conflicts with the Marker Window
When using IXgen you typically won’t bother using the FrameMaker marker window. 
However, from time to time you might use the marker window for a single marker edit. 

CAUTION: Do not use the marker window if you’ve already generated an editable 
marker list with Gen Editable Marker List and have yet to apply the list 
using Apply Edited Marker List. Apply the current editable marker list 
before using the FrameMaker marker window.

You can freely use the marker window before using Gen Editable Marker List, and then 
after using Apply Edited Marker List.

The IXgen Tool Set
IXgen tools broadly fall into these categories:

• Editable marker list tools generate the editable marker list, provide processing 
when markers have been collected into the edtible marker list, and then apply the 
list contents back to the source markers. These functions are only available within 
the editable marker list.

• In-line marker tools provide editing of markers from within the source document.
• Creation and deletion tools provide several ways to generate new markers, and 

delete duplicates.
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The next several sections describe the IXgen tool kit in detail. Table 1 summarizes the 
tool functions. The illustrations starting on page 29 provide tool road maps. 

Table 1 IXgen Function Summary 

IXgen Function Brief Description Page

Editable Marker List Tools

Gen Editable Marker List Generate an editable list of markers 33

Apply Edited Marker List Apply edited marker list back to source markers 
(includes the Split and Permute options) 37

Create Subentries Generate second-level entries when two or more first-
level entries share a common root word or phrase 43

Flip Entries
Reverse first and second level entries; optionally keep 
a copy of the original entry or make a reference to the 
original form

44

Speed Flip
Same as Flip Entries, but no set-up dialog box 
appears. Settings are taken immediately from Flip 
Entries

47

Capitalization Control capitalization standards 58

Elevate Unique 
Subentries

Append single second-level entries to the root first-
level entry 48

Validate References Check that the entries referenced by “see”, “see also” 
and similar references actually exist 49

Show Marker Char Tags 
as Text Cmds

Convert applied formats to embedded format 
commands 56

Show Marker Char Tags 
Applied

Convert embedded font-change commands to character 
format tags and apply to the affected text 50

Copy Char Catalog to 
Template

Write current Editable Marker List Character Formats 
to the edtblist.fm template document. 57
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In-line Marker Editing

Expand Markers Place marker text in main body text 61

Collapse Markers Return expanded marker text to markers 63

Create and Remove Markers

Markers from Keywords Generate new markers by searching for keywords 65

Markers from Paragraph 
Tags Generate new markers from selected paragraph tags 72

Markers from Character 
Tags Generate new markers from selected character tags 74

Delete Redundant Markers Remove back-to-back markers that are duplicates 77

Table 1 IXgen Function Summary (Continued)

IXgen Function Brief Description Page
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Figure 1 and Figure 2 illustrate the IXgen tools listed in Table 1, immediately above. Each 
tool is described in later sections.

Figure 1 IXgen Tool Map, General Functions
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Figure 2 IXgen Tool Map, Editable Marker List Functions
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Validate References

A x
A y
A z

A:x
A:y
A:z

A
y
z

x A:x
B:y
C:z

A, x
B, y
C, z

A x
A y
A z

A x
B y
C z

Flip Entries (copy and flip):

Flip Entries (flip reference):

B:AA:B

A:B;B:AA:B

A:B; B, A, See A:BA:B
A, See X X

File Format View Special Graphics Table IXgen

Gen Editable Marker List...

(Split and Permute)
Expand Markers...
Collapse Markers...
Markers from Keywords...
Markers from Para Tags...
Markers from Char Tags...
Delete Redundant Markers...

Speed Flip

Elevate Unique Subentries...
Validate References...

About IXgen Release 7.2...
IXgen License....

Create Subentries...

Flip Entries...
Capitalization...

Apply Edited Marker List...

Show Marker Char Tags as Text Cmds

Edit Window Help

Show Marker Char Tags Applied
Copy Char Catalog to Template

Show Marker Char Tags as Text Cmds

Show Marker Char Tags Applied

<Emphasis>animals:lion

animals:lion

utilities
Display Editable List Toolbar
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Sequence of IXgen Tool Use
Table 2 shows “typical” usage sequences based on two scenarios: creating an index from 
scratch and editing/maintaining an index.
Of course, you are not locked into any particular usage sequence. Use the tools as needed 
in any logical order.

Table 2 Typical IXgen Tool Usage Division

IXgen tools for Index Creation... IXgen tools Index Editing...

Markers from Keywords, Markers from 
Paragraph Tags, or Markers from 
Character Tags create initial raw 
entries. (Use Delete Redundant 
Markers if one of the above tools is 
inadvertently run more than one time on 
the same source text.)

Gen Editable Marker List is usally an 
editing tool, but can also supports 
marker additions within the editable 
marker list. The “;” (semicolon) syntax 
is used to delimit additional index 
entries within a single marker

Flip Entries exchanges first and second 
level entries, and can optionally retain 
the original entry or create a “see” or 
“see also” type reference based on the 
exchanged entries.

Apply Edited Marker List reflects any 
changes made (such as added markers), 
and accesses the Permute (rotate) 
marker text and Split multiple index 
entries into separate markers 
functions.

Gen Editable Marker List collects a list of 
the current markers. You can make regular 
textual edits in the marker text listed, 
including spell check and find/change.
Apply Edited Marker List reflects any 
changes made, and accesses the Permute 
(rotate) marker text and Split multiple 
index entries into separate markers 
functions.
Other editing functions include:
Expand Markers to see (and edit) the 
markers in body text context where the 
marker appears. When finished (and before 
using other marker functions or updating, 
use Collapse Markers to return expanded 
marker text to the source markers.
Delete Redundant Markers removes 
unwanted duplicate markers.
Create Subentries supports better structure 
by building second-level entries based on 
common root words or phrases.
Elevate Unique Subentries removes single 
second-level entries by appending them to 
the companion single first-level entry.
Validate References checks “see” and “see 
also” and other types of references.
Show Marker Char Tags as Text Cmds and 
Show Marker Char Tags Applied change 
the visual display of marker text 
formatting. Formatting can be seen or 
applied as embedded format commands, or 
as character tags.
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IXgen Tool Reference Pages
The next several sections describe the various IXgen tools using a standardized reference 
format.
This general format is overviewed next:

Explanation of IXgen Tool 
Descriptions

This section describes the tool documentation format

Purpose: States the reason for the tool.

Method: Summarizes how the tool works.

Configuration: Provides an abstract of how you configure the tool.

Dialog Settings: Provides a sample screen shot of the tool set-up dialog, along with specific 
explanations of dialog controls.

Text Selection: Discusses how best to use a text selection with this particular tool (see 
Operational Scope of IXgen Tools on page 23 for a general discussion).

Tips: Gives practical suggestions and recommendations for tool use. 

NOTE: Brings to your attention some special consideration about the tool. 

CAUTION: Warns about some action or configuration that could harm your textual 
data. Always back up your files.

Not all headings are used in all sections.
Additional headings appear as needed to provide supporting information about a tool.
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Gen Editable Marker List
Generate an editable list of markers

Purpose: Generate a list of markers and place them into a regular FrameMaker 
document that can be edited and manipulated without using the marker 
window. Many markers can be edited at the same time. The editable marker 
list supports additional IXgen tools including Create Subentries (page 43), 
Elevate Unique Subentries (page 48), Flip Entries (page 44), Validate 
References (page 49), Capitalization (page 58), Show Marker Char Tags 
Applied (page 50) and Show Marker Char Tags as Text Cmds (page 56).

Method: You are initially presented with a scroll list from which to verify or reselect 
the marker types to be collected. The marker text is then collected into a 
table and placed in a new FrameMaker document. Spell checking, find and 
change, and all types of general edits can be accomplished. This generated 
editable marker list is typically a “throw-away” document used only during 
the current marker editing session. However, you can save the editable 
marker list to a name of your choosing, reopen it later, and then continue 
editing markers; or use the Apply Edited Marker List function to write the 
markers back to the source document(s). But be sure to review the “Caution” 
statement immediately below if you plan to save and later use a marker list.

NOTE: You can reach all of the editable marker list tools through the editable 
marker list toolbar. Choose IXgen>Display Editable List Toolbar.

CAUTION: When using Gen Editable Marker List and Apply Edited Marker List, do not 
simultaneously perform any source document edits. A bug in FrameMaker 
may cause internal marker ID numbers to change if you perform such 
operations. This in turn will cause an Apply Edited Marker List operation to 
fail. If this happens, the last bullet point in Problem 12: on page 91 offers 
a suggestion for possible recovery of your work

Always apply the current edited list before making any edits in the source 
document(s). Regenerate the editable marker list when you wish to resume 
marker list editing. You can save an editable marker list and come back to 
its editing later, but you must not make any other edits in the source 
document(s) for that list until the list has been applied.

If you are working on a large editable marker list, occasionally saving to 
disk or engaging the FrameMaker autosave funtion 
(FrameMaker>Preferences>General) is highly recommended. These action 
help preserve your work against unexpected system problems.
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Figure 3 Generating an Editable Marker List

Source Document

Indicates a marker

IXgen Editable Marker List

Collect markers from document(s),
sort (or not), and place in the
editable marker list document

Editable Marker List

Dialog Settings: Select the type of markers to collect for the editable marker list. More than 
one marker type can be collected at one time.  
 
Select sort/no sort. “Sort” provides alphabetical context and is the 
recommended setting for most uses. “No sort” presents markers in the 
internal object list order, which typically approximates page order but exact 
page order might not always be the case.  
 
“Show complete paths” provides full source document location information, 
but will usually cause a line wrap in the “source document” listing field of 
the dialog.

NOTE: When editable marker list sorting is active, IXgen follows any sort overrides 
that you have placed in the markers. Thus, an entry such as 
elephants[zz], will be sorted well toward the end of the editable marker 
list rather than closer to the beginning, among any “E” entries.

CAUTION: When you wish to delete a marker, do not remove the entire row of the table 
that holds that marker. Instead, simply remove (clear) the text from the cell 
in the “Edit Marker Text In this Column”. IXgen will see the empty cell and 
know to delete the marker. However, if the entire row is missing, IXgen no 
longer has a reference to that marker.
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If the Apply character formatting to editable marker list document option is 
checked, Show Marker Char Tags Applied (page 50) will automatically be 
invoked once the editable marker list is loaded. 

Tips: • Hypertext links are available in the “Navigate” column of the document 
created by Gen Editable Marker List. You can go directly to the source 
page of a given marker. Place the mouse cursor in the gray box (left-most 
column of the table) and Control-Alt-click. FrameMaker will jump to the 
source document and page for that marker. (The editable marker list 
remains on screen so that you can easily return to it. However, the editable 
marker list may be underneath the source document jumped to and not 
visible. Simply minimize the source document when finished with your 
review.)

CAUTION: Remember, as noted in the “Caution” on page 33, do not make any edits in 
the source document that you might jump to. If you need to edit the source 
document, first use the Apply Edited Marker List function, then you can 
safely make the source document edit(s). When you wish to continue marker 
editing, re-run the Gen Editable Marker List function.
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• IXgen will not support adding new markers by adding new table rows to 
the editable marker list. But you can append a new index entry to existing 
marker text by using the standard FrameMaker index entry delimiter, the 
“;” (semicolon). Remember, however, the 255 character limit for marker 
text that is imposed by FrameMaker.

• Because the editable marker list consists of a regular FrameMaker table 
located in the body of a regular FrameMaker document, you can use the 
spell checker and find/change to help with editing.

• When applying an edited marker list (described starting on the next page) 
you can Split multiple index entries into separate markers (page 38), 
Permute (rotate) marker text (page 39), and preserve character catalog 
changes in the editable marker list for future use by selecting Copy Char 
Catalog to Template (page 57).

• If you don’t like the appearance of the editable marker list, you can open 
the Gen Editable Marker List template document 
(<FM_install_folder>\ixgen\templates\edtblist.fm) as a 
regular FrameMaker document and make changes to it. You can make font 
and some layout changes. Just be sure that you don’t change paragraph or 
flow tag names. For more details review Changing the Fonts Used by 
IXgen starting on page 17.
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Apply Edited Marker List
Apply edited marker list back to source markers (includes 

the Split and Permute options)
(Editable Marker List Function)

Purpose: Update the source markers with the markers listed in the editable marker list 
document created by Gen Editable Marker List.

Method: Marker text from the generated editable marker list replaces the marker text 
in the corresponding source markers. Thus, any changes made in the editable 
marker list are reflected back to the markers in the source document(s). 
Spell checking, find and change, and all types of general edits can be done 
to marker text while it is the editable marker list.

Figure 4 Applying an Edited Marker List

Source Document

Indicates a marker

IXgen Editable Marker List

Write revised text for each marker
in the editable marker list document
back to markers in the source
document(s).

(Discard when done)
Editable Marker List

Configuration: When the editable marker list was created, the types of markers to assemble 
were selected using the dialog box that appeared when Gen Editable Marker 
List was invoked. Along with editing the marker contents, you could also 
change the marker type. Refer to Converting from one Marker Type to 
Another on page 79 for details on this procedure.
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Dialog Settings: Select any one or all of “Permute”, “Split”, and “Save Current Editable 
Marker List to ixgen\templates\edtblist.fm”. These options are explained in 
the next sections.

Tips: After completing a cycle with Gen Editable Marker List and Apply Edited 
Marker List, you have only affected the markers in the source documents. You 
have not altered the text in any generated documents, such as an IX document. 
To follow through on any marker changes you make using IXgen, be sure to 
regenerate the FrameMaker book (or document, if you have a stand-alone index 
for a single document).

Text Selection: You can limit the Apply Edited Marker List action (including Split, Permute, 
and Capitalization, described below) to specific cells by selecting them in 
the editable marker list table. If a text selection is detected during the apply 
operation, only selected marker text is applied rather than the entire list.

The three optional apply functions, “Permute”, “Split”, and “Save Current Editable 
Marker List to ixgen\templates\edtblist.fm”, are explained next.

Using the Split Function

FrameMaker can support multiple index entries per marker text string and delimits them 
with a semicolon. Select Split multiple index entries into separate markers so that IXgen 
will create new markers as needed to store only one index entry in each marker.

Some people find the one entry/one marker approach easier to maintain; other people 
prefer to have related entries in one marker. However, this limits the utility of sorting the 
markers in the editable marker list — the “add on” entries will be sorted according the 
first entry in the marker and not be “seen” in their normal sort order.

Note that a marker entry has a 255 character limit (imposed by FrameMaker). The split 
function can be used to assure that each marker has the maximum possible space for long 
entries.
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Using the Permute (Rotate) Marker Text Function
A generally useful indexing technique is a circular rotation of the words in a single-level 
entry. A new single-level entry is created with each rotation. For example, this phrase:
 quick brown fox
could be rotated twice to produce two new additional single-level entries:
 brown, fox quick  
 fox, quick brown  

To more clearly see the pattern consider this abstract example:

aa bb cc dd ee ff permutes into these 
new entries:

ff, aa bb cc dd ee  
ee ff, aa bb cc dd  
dd ee ff, aa bb cc  
cc dd ee ff, aa bb  
bb cc dd ee ff, aa

Select Permute (rotate) marker text by clicking the associated check box in the Apply 
Edited Marker List dialog box.
NOTE: If not already selected, selecting Permute (rotate) marker text will also 
automatically select Split multiple index entries into separate markers. This precludes 
the accidental overrun of a marker should the new permuted marker length (with all the 
new permutations of the original entry added) exceed 255 characters. Conversely, if you 
deselect the split option, the permute option is also deselected.
Also note that this function is performed during Apply Edited Marker List. The source 
markers are thus affected. As a convenience, IXgen then updates the editable marker list 
to reflect any splitting or permutation that occurred. However, this updated list is not 
resorted alphabetically. To obtain a resorted editable marker list, discard the current list 
and regenerate using Gen Editable Marker List.

Avoiding Nonsense Rotations
To minimize nonsense rotations, IXgen offers permutation controls (page 40) and follows 
some basic rules:

• Only single-level entries are rotated. Generally, nothing is gained by rotating 
lower levels where the rotated entries would appear together in a relatively small 
sublist.

Alternately, multiple variations of a first level, with identical subentry lists, 
would be cumbersome. If variants are still desirable for main entries with 
subentries, rotate the first level by hand. Assign one variant to “hold” the 
subentries and adjust the markers containing the subordinates as needed. (You 
can use Find/change on a editable marker list.) For the other variants, use “see 
also” to refer to the variant with the subordinate list. Include a “<$nopage>” 
in these referral entries. The Flip Entries tool (page 44) might also be helpful 
to you.
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• If the special control “<$nopage>” appears in a marker, the marker is excluded 
from rotation activity.

• Entries with commas are not rotated. When a comma is detected, the assumption 
is that a rotation has already taken place, either from a previous session with 
IXgen or from a manual rotation done by the index author. (If you still need a 
rotation on a entry that was not rotated because of a comma, do the rotation 
manually.)

The Permute (Rotate) Marker Control Lists
The IXgen template <FM_install_folder>\ixgen\templates\permctrl.fm 
has two control lists shown in two columns.

Using FrameMaker, you can open permctrl.fm and edit these lists to control how 
rotations will occur. (Usage notes are included in permctrl.fm; the following 
paragraphs repeat that information.)

NOTE: Only the one control file, named permctrl.fm, can be used, and the file must 
be in the <FM_install_folder>\ixgen\templates folder of your FrameMaker 
installation.

You can create alternative permctrl.fm files, but only one of these alternatives can be 
used at any one time. Store alternatives using different names. When ready, copy the 
selected control file into the template folder using the permctrl.fm name for the new 
file.
40 www.fsatools.com 160301 IXgen 7 & 7-10 (for FrameMaker 7 through 15)

www.fsatools.com
www.fsatools.com


Save Character Catalog IXgen Tool Reference Pages
Entries in the left-hand column of permctrl.fm suppress all rotations if any entry in 
the list occurs any place in the candidate marker.

Entries in the right-hand column of permctrl.fm discard the rotation candidate if the 
first word of the proposed rotation is in the right-hand list. This control is aimed at 
preventing the indexing of prepositions, conjunctions, and so on. You can also add your 
words to this list.

When IXgen considers how to break apart a marker in preparation for rotation, marker 
text is viewed as a sequence of “atoms”. An atom is typically a word delimited by regular 
spaces. But an “atom” can also be a sequence of space-delimited words that appear as part 
of a font change in the index entry. Words in a font change are assumed to be special (a 
multi-word proper name, for example) and thus will not be divided during marker 
rotation.

“Atomization” returns to space-delimited words when the end of the entry (or marker) is 
reached (in preparation for the next marker) or if an explicit <Default Para Font> 
font command is encountered.

Once permutation is completed, you will want to examine the result of the latest Gen 
Editable Marker List invoked as part of the Permute (rotate) marker text function. Make 
any final needed changes or adjustments, then Apply Edited Marker List one last time. 
While permutations will not happen again because of the “no rotation on embedded 
comma” ruled noted above in Avoiding Nonsense Rotations, deselect the split and permute 
options to save processing time.

Checking Rotations
While the rotation rules and controls minimize nonsense rotations, such unwanted 
rotations might still occur. You can visually scan the resulting editable marker list. All 
rotations for a given marker appear in juxtaposed table cells, so you can readily view 
related rotations. Delete the marker text for any useless rotations (but do not delete the 
entire row from the list table, just the text). Use Apply Edited Marker List again, but this 
time don’t select the Permute option. The corresponding markers in the source document(s) 
will be deleted.

A second approach is to immediately generate the index at the document or book level. 
Seeing the index in its final form can be helpful in spotting problem entries. You can then 
edit the existing editable marker list, or you can discard the current editable marker list, 
and use Gen Editable Marker List again to create fresh list. The latter approach is handy 
if you’re working from a freshly generated index. The sort-orders will closely match, 
making it much easier to locate the markers you want to delete based on what you saw in 
the IX document.

After checking and deleting marker text for useless markers in the editable marker list, 
reissue Apply Edited Marker List to update the markers in the source document(s).

Save Character Catalog
If during the current session with the editable marker list you’ve added or modified 
character tag formats, you can choose to save those character tag updates to the editable 
marker list template document. (This is the template on which each generation of the editable 
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marker list is based.) Updated character formats are then available for each future session with 
the editable marker list.

CAUTION: Any character format tags of the same name already existing in the editable 
marker list template will have their properties overwritten with the properties 
from the current editable marker list. If you wish to preserve current tag 
properties, make sure the “Save Character Catalog” option is not checked.
42 www.fsatools.com 160301 IXgen 7 & 7-10 (for FrameMaker 7 through 15)

www.fsatools.com
www.fsatools.com


Create Subentries IXgen Tool Reference Pages
Create Subentries
Place entries under a common root entry

(Editable Marker List Function)

Purpose: Generate second-level entries when two or more first-level entries share a 
common root word or phrase. This will help the visual and logical 
organization of your index.

Method: Search single-level index entries for the occurrence of common root words 
and phrases. Each candidate must occur in two or more entries. When found, 
insert a colon (“:”) at the end of the shared root word or phrase, thus 
creating a two-level entry.

In more detail: the first-level entry strings of existing two-level entries are 
searched against a reverse-sorted list of single-level entry candidates 
(markers within your text selection in the editable marker list). If a substring 
match occurs, the unique text in the single-level entry can successfully 
become a second-level entry of the existing first-level entry text.

If no existing two-level entries have a match (or there are no existing two-
level entries), a list of reverse-sorted single-level entries are checked for 
common root text. 

Trailing commas left over in the first level entry are removed.

Washington State: bird 
Washington State, flower 
Washington State, song 
Washington State, capital 

Washington State: bird 
Washington State: flower 
Washington State: song 
Washington State: capital 

Dialog Settings: No settings. Click “Create” when ready to begin.

Text Selection: When using this tool, a text selection in the editable marker list to limit 
processing is suggested. Not all instances where a subentry could be created 
will be desirable; the style rules you use for creating subentries will dictate 
your use of Create Subentries.

Tips: As you review your editable marker list, you will probably see clusters of 
entries that could be placed under a common root entry. Generally, you’ll 
select those clusters one at a time and use Create Subentries. This group-
by-group approach gives you good control over the streamlining of your 
index.

NOTE: For best results with Create Subentries when using a book file, be sure all 
files that contribute index markers to the book are selected prior to using 
Gen Editable Marker List.
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Flip Entries
Exchange, copy, or make references based on 

entries with two levels
(Editable Marker List Function)

Purpose: Reverse first and second level entries; optionally keep a copy of the original 
entry or make a reference to the original form. A “vertical permutation” of 
two-level entries occurs.

Method: Based on the Flip Entries Dialog settings, entries with two levels can have 
the content of the two levels exchanged; a copy made and the copy flipped 
leaving the original entry in its original form; or a flipped entry can become 
a “see” or “see also” reference.

Dialog Settings: Refer to the sections immediately below for a description of each portion of 
the Flip Entries setup dialog box.
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Flip Type
Select regular level flip or reference flip. Level flip exchanges the contents of the first 
and second level portions of the entry. Reference flip does this as well, but the flipped 
version includes the contents of the Reference Text box.

Flip Entries (flip):

Flip Entries (copy and flip):

Flip Entries (reference flip):

B:AA:B

A:B;B:AA:B

A:B;<$nopage>B, A, See A:BA:B

NOTE: Using “Copy and Flip” when “Reference Flip” is selected is highly 
recommended. Otherwise, the reference might not have a valid target entry.  
 
The first time you select “Reference Flip,” the “Copy and Flip” option is 
automatically selected. However, you can still deselect “Copy and Flip” if 
you wish. (This might be appropriate if you already have a matching 
destination entry in place.)

Reference Flip Options
Enter the textual reference form use when Reference Flip is selected. Typically, such 
entries should also include the “<$nopage>” control, but you can omit the embedding of 
this control by unchecking the <$nopage> check box.
Note that the first separator in the flipped version (the comma and space between the 
initial “B” and “A” components in the flip reference abstract example above) cannot be 
changed through the Flip Entries dialog box. However, this separator can be changed in 
the ixgen.ini file. Open ixgen.ini with a plain text editor (such as notepad) and 
change the text value of the FlipFirstSeparator parameter to the separator you 
need. (If you choose a reserved character, such as a semicolon, be sure to escape the 
character with a backslash (“\”) character.)

Tips: You can verify any references you create with Reference Flip using Validate 
References (page 49).

When making a reference, typically you will reference a first-level entry that 
has two or more subentries. If no such list exists, perhaps the current entry 
should be included as a subentry elsewhere.

Flip Action
“Flip only” means that the flip operation will exchange the contents of the first and 
second level components of the entry. The original form of the entry no longer exists.
“Copy and Flip” makes a copy of the entry and exchanges the contents of the first and 
second level components in the copy. The original form of the entry is preserved as a 
separate entry.
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“Copy and Flip” is recommended for most applications.

Sort Override Interaction
Sort overrides, using the square bracket syntax, move an entry to a user-determined 
location in the index. An entry such as “AAAA:BBBB[z]” means that the string 
“AAAA:BBBB” will appear under the “Z” entries in the index.
Often a sort override on the flipped entry (BBBB:AAAA) will no longer have any specific 
use because the flipped version, BBBB, will appear in the same place as the unflipped 
version (assuming that the same sort override remains on both entries).
For most applications, we recommend selecting “Remove Sort Override from Flipped 
Entry”.
Perhaps you have a specialized entry with a particular sort override, where a flip 
operation would reduce or negate the usefulness of a flipped entry. In these instances we 
suggest setting “Do not flip if a sort override is present”.
Finally, if you wish to retain the sort override, it will travel with the flipped entry. But 
again keep in mind that if using flip only, the entry, though flipped, will go to the index 
sort location dictated by the sort override.
If you do retain the override, note that while simple in concept, sort overrides in 
FrameMaker can get very complex and exhibit complex behaviors. This is particularly 
true of multiple index entries per marker and sort overrides found in multi-level entries.
“Nonsense” flips can be generated, such as making a “see” or “see also” reference flip 
where a sort override is carried through to the flipped version. In this instance, the 
referral would probably be pointing to the entry immediately above or below itself. 

Handling the 255 Character Marker Length Limit
When building markers with Copy and Flip and particularly Flip Reference, it is possible 
that the marker length will exceed 255 characters. In this case, IXgen creates new markers 
to hold the flipped entries.

NOTE: Flip Entries only works on two-level entries. Flip Entries does not work 
with single level entries, or on entries with three or more levels.
46 www.fsatools.com 160301 IXgen 7 & 7-10 (for FrameMaker 7 through 15)

www.fsatools.com
www.fsatools.com


Speed Flip IXgen Tool Reference Pages
Speed Flip
Execute the Flip Entries function immediately

(Editable Marker List Function)

Purpose: Enter a Flip Entries operation immediately. The Flip Entries setup dialog 
box does not appear.

Method: Use the most recent settings from the Flip Entries dialog box and execute 
the Flip Entries command.

Configuration: None required, not even a confirming start-up dialog box.

Dialog Settings: Values are taken from the last-used Flip Entries setup dialog box. No 
settings can be changed with Speed Flip so no dialog box appears.

Text Selection: As with Flip Entries, a text selection in the Editable Marker List is 
recommended when using Speed Flip.

NOTE: Speed Flip has a unique behavior. If no text selection is present, the editable 
marker list table row where the insert point is located is treated as if it were 
selected. Only the marker in that table row is processed. This assumption, 
combined with immediate entry into flip functionality, makes for very rapid 
and controlled utilization of Flip Entries. If you want more than one row 
flipped, select the additional rows before using Speed Flip.

CAUTION: Carefully check the dialog settings and results by using the Flip Entries 
command at least once before using Speed Flip. If you have not configured 
the dialog as you want, Speed Flip can help you quickly make the same 
configuration mistake over and over again. We suggest trying your flip 
operation a few times from Flip Entries before using Speed Flip.  
 
When using Speed Flip, carefully examine the results from time to time to 
be sure you are achieving the desired results.
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Elevate Unique Subentries
Append single second-level entries to the root entry

(Editable Marker List Function)

Purpose: Append single second-level entries to the root first-level entry

Method: Check for entries with two levels. If there is one and only one entry with 
this root and second level entry, then append the second level entry to the 
root, using the user-specified separator character or string.

Dialog Settings: Select the character or string you’d like to appear between the root portion 
of the entry the second-level component that will be appended.

NOTE: If you are checking an index for unique subentries, be sure that all the 
markers that comprise the index were collected.  
 
For example, before using Gen Editable Marker List on a stand-alone 
document, remove any text selections. If running Gen Editable Marker List 
from a book, be sure that all documents that contribute markers to the book 
index have been selected.

If not all markers are collected, a given entry which appears to be unique 
may in fact not be unique. You might decide to elevate the second-level 
entry. Then, in the final index, you would have an inconsistent mix of 
single-level entries and unique subentries. Should this happen, Create 
Subentries (page 43) can unify the various combinations of single and 
multi-level entries that share the same root word or phrase.

Text Selection: A text selection with this tool is not recommended, unless if you have some 
entries that you wish to keep as a stand-alone two-level entries, even though 
there is only one second-level component.
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Validate References
Check that references made inside the index are valid

(Editable Marker List Function)

Purpose: Check that the entries referenced by “see”, “see also” and similar references 
actually exist.

Method: Scan the editable marker list, looking for the type(s) of referrals listed in the 
Validate References template 
(<FM_install_folder>\ixgen\templates\valrefctrl.fm). 
When a listed referral is found, isolate the referenced text string, then look 
to see if that the string exists as a first-level entry elsewhere in the 
collection of markers. To pass the validation test, the referenced text must 
match the complete first-level entry text of some other entry, and must 
match fully the text string being searched.

Matches are case-insensitive, and character formats are ignored. Substring 
matches are precluded.

Configuration: List the reference strings to be checked in the Validate References template, 
located in: 
<FM_install_folder>\ixgen\templates\valrefctrl.fm

NOTE: If you are checking a book index, be sure that when the editable marker list 
was collected, all source documents contributing markers to the book index 
were included.

Text Selection: Not recommended. The entire collection of markers would not be searched.

Dialog Settings: None. Click “Go” when ready.

Tips: If several reference failures are reported and you generated the editable 
marker list from a book file, be sure that all the appropriate body documents 
were selected from the book file when you ran Gen Editable Marker List.

Fixing broken references requires inserting a matching entry, typically using 
the <$nopage> command. Or, fixing an entry might be as simple as 
correcting the spelling or wording of either the referral text or the target 
text.
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Show Marker Char Tags Applied
Convert embedded font-change commands to character 

format tags and apply to the affected text
(Editable Marker List Function)

Purpose: Show marker text character formatting in a visual form.

Method: Scan marker text for embedded text-based format commands in the form of 
<tagname>. When found, extract the tag name from the marker text and 
find the end point of the formatting. The end point of the formatting is 
defined as:
• the end of the entry level (colon break)
• entry delimiter (semicolon or end of marker)
• presence of another font change command
• presence of the <Default Para Font> command

Perform a look-up of that tag name in the character catalog of the current 
editable marker list. If not found, check the character catalog of the IX 
document associated with a book (assuming this editable marker list session 
was initiated from a book) or the source file if this editable marker list 
session was initiated from a single FrameMaker document.

If the character tag was found outside the editable marker list in the IX or 
source document character catalogs, add the tag and its properties to the 
current editable marker list character catalog.

If the tag is not found, add the tag name to the editable marker list character 
catalog and copy the generic font properties from the 
UncataloguedCharTagTemplate entry.

Configuration: Not required.

Dialog Settings: None. Action is immediate. However, invocation of the Show Marker Char 
Tags Applied action can be preselected in the setup dialog box for Gen 
Editable Marker List (page 33).

Tips: Review the next seven sections of this document for an in-depth discussion 
of how character formatting in the editable marker list works.

Character Formatting in Markers
FrameMaker applies character formatting to index entries using this command syntax in 
marker text:
<tagname>marker text<Default Para Font> more marker text
50 www.fsatools.com 160301 IXgen 7 & 7-10 (for FrameMaker 7 through 15)

www.fsatools.com
www.fsatools.com


Character Formatting in Markers IXgen Tool Reference Pages
Bold and italic formatting emphasizes certain aspects of your index. But you can use other 
formatting styles suited to your needs, such as different font sizes, colors, and so on. Set 
up these variants as needed using character tags.
In a large group of markers, such as is often found in the editable marker list, seeing such 
plain text format command strings can be difficult.
IXgen can read the embedded character format commands and apply the character formats 
for you. This can make marker character formatting readily visible on screen. Later, when 
you apply the editable marker list, IXgen converts these applied character formats back 
to the embedded text commands expected by FrameMaker during its generate cycles.
You can tell IXgen to display marker text formatting as applied in one of two ways:

• Check the “Apply character formatting to editable marker list” item in the Gen 
Editable Marker List setup dialog box. This will automatically convert embedded 
format commands to formatted text as the markers are loaded into the new editable 
marker list.

• Select the Show Marker Char Tags Applied command from the IXgen menu when 
an editable marker list is the active document.

Embedded format commands are then applied as character tags. Here are some examples:.

Standard Marker Text Editable Marker List Formatted Display

<Emphasis>animals:lion animals:lion

<Emphasis>animals:habitat animals:habitat

documentation, <emphasis>see 
<Bold>technical writing

documentation, see technical writing

While still in basic marker format (that is, level indicators such as the colon are still 
visible), formatting can now be seen. However, for editing purposes while using the 
editable marker list, you can enhance the display of marker character formatting. This is 
discussed below in Display Fonts vs. Production Fonts.

NOTE: Don’t confuse the character formatting that can be done to marker text with 
the general document formatting done at the character and paragraph level. 
You cannot, for example, change the appearance of IX document page 
numbers from format commands within the markers, nor can you change the 
default paragraph font formatting using a marker format command.

You can think of embedded character format commands as having the ability 
to make exception formatting to the marker text, but such marker format 
commands cannot readily change the underlying formatting of the generated 
document.

Underlying index formatting is controlled in the reference pages of the 
generated document, and in the character and paragraph catalogs of that 
document. For more information about formatting, refer to the “Formatting 
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Lists and Indexes” section of the “Tables of Contents and Indexes” chapter 
of the FrameMaker User Guide.

Formatting Process and Sources of Character Formats
When IXgen builds the editable marker list, IXgen scans a number of sources for the 
specific character format properties associated with each marker format command. 
Figure 5 shows how the formatting process works, along with the sources and hierarchies 
of character tag formats

current edtblist.fm catalog

first IX document listed in book file

catalog from source file

internal template character tag,

IXgen Editable Marker List

Editable Marker List

if not found then:

if not found then:

if not found then as a last resort:

< >

1. Examine each marker:

2. Look for formatting:

3. Get format name:

4. Search for the format name:

5. Remove font change command string and apply format properties:

UncataloguedChartagTemplate

< >

< >

IXgen Editable Marker List

6. Applied formats are returned to embedded commands during the apply
process or on demand using “Show Marker Char Tags as Text Cmds”

Figure 5 Editable Marker List Character Tag Processing

As indicated, the first place sourced for character formats is the current editable marker 
list document, which is copied from the template file, edtblist.fm (located in 
<FM_install_folder>\ixgen\templates).

For best use of the editable marker list formatting feature, keep the character formats you 
use in marker formatting up-to-date in the edtblist.fm template document. You can 
do this in different ways:

• Using the character designer, you can manually edit the formats in edtblist.fm 
template document prior to using Gen Editable Marker List.

• while working in an editable marker list, you can write updated character formats 
back to the edtblist.fm template by using Copy Char Catalog to Template.

• you can check the “Save current Editable Marker List character catalog to 
Edtblist.fm template” option in the Apply Edited Marker List setup dialog box. 

• you can manually copy formats from other documents, such as the IX document.
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More about UncataloguedCharTagTemplate
If the character format name specified in an embedded command cannot be found in any 
of the places noted in Figure 5 on page 52, IXgen generates a new character tag using the 
embedded command name. Initial character format properties for the new tag are copied 
from the UncataloguedCharTagTemplate template tag. By default, these properties 
are red and double underline, which will make all such tags plainly visible in the editable 
marker list document.
If you wish, you can change the properties for this tag in the edtblist.fm template 
document (located in <FM_install_folder>\ixgen\templates).

Display Fonts vs. Production Fonts
An established character tag used in marker character formatting will have the same tag 
name in these places:

• IX document catalog
• the tag name in the format command embedded in the marker
• the editable marker list created for the current editing session

The particular properties for a given character tag can be set up in the IX document (your 
production document) very differently from the editable marker list (template or session 
document).
During marker editing in the editable marker list, this capability can be invaluable. You 
can make various formats visually “jump out” of the editable marker list by exaggerating 
or enhancing various display attributes, but you need not carry these exaggerations over 
to the production IX document. In that document, use the formatting dictated by your 
production requirements.
For example, in an editable marker list consisting of just a few Emphasis tags scattered 
among a large number of markers, the italic formatting can be easily overlooked. (The 
Emphasis tag is typically used to italicize.) You could enhance the Emphasis tag in the 
editable marker list by making the emphasis tag red. For a bold tag in the editable marker 
list, you could make the characters several points larger than the default text size.
In the current editable marker list, make any desired changes using the character designer 
and apply your changes. Now you can much more readily see your formatting. And, 
because the editable marker list template character catalog is not fed back to the IX 
document, you need not worry about losing your production settings for various character 
tags.
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Figure 6 shows these formatting ideas applied to two sample markers.

Raw Markers

<emphasis>animals:lion
see also <bold>species

Editable Marker List Document Production IX Document

animals:lion

see also species
animals

lion

(formatted with visual enhancements for editing) (your regular formatting for production)

see also species

Figure 6 Editable marker list display fonts separate from production fonts

In our own demoixgn.pdf file (the IXgen demonstration guide included with your 
IXgen distribution), we used several character formats in the FrameMaker index of that 
document. As you can see, magenta and a custom red were used to show those character 
applications within the editable marker list. Of course, such colors would be a poor design 
choice in the production version of the index document, but here, while editing, they 
make seeing the formatting quite easy.

If you wish to keep any format exaggerations you’ve made for future sessions with the 
editable marker list, save the changes using Copy Char Catalog to Template, or check the 
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“Save current Editable Marker List character catalog to Edtblist.fm template” option in 
the Apply Edited Marker List setup dialog box when you apply the editable marker list.

If You’ve Created New Char Formats in the Marker List
The IXgen editable marker list formatting feature will probably inspire the creation of 
new character tags as you edit your markers in the editable marker list. This is perfectly 
fine. During the apply operation, IXgen will convert the name of the new tag(s) to the 
proper embedded character format commands and place them in the markers as they are 
written back to the source documents.
However, do not forget to add the same-named character tag (along with the appropriate 
format properties) to your IX document — the FrameMaker-generated index document 
you publish. If this is not done, the tag will not appear formatted in your production IX 
document because FrameMaker cannot find the character tag name in the IX document 
character catalog.
If you wish, use File>import>formats to transfer the editable marker list character 
catalog over to the IX document. However, do this only if the font properties you use in 
the editable marker list will be appropriate for your published IX document. As noted in 
the section immediately above, Display Fonts vs. Production Fonts, any given character 
tag can have two different sets of character format properties for the two different 
purposes: editing or publishing.
If the format particulars will not be appropriate for the production IX document, create 
the character catalog entries by hand, or immediately adjust the font properties for the 
new character tags you just copied to the IX document.

Capitalization Issues
Character tag names are case sensitive. The character tag Emphasis is not the same as 
the tags emphasis or EMPHASIS. These are all separate tags in the character tag 
catalog. Be aware of this as you work with character formatting.
The IXgen Capitalization tool properly handles embedded format commands. Regardless 
of the capitalization standard selected, any text found inside angle brackets is assumed to 
be a character tag name and is not changed.

IXgen Main Menu Format Check Marks
In the main IXgen pull down menu, the current format display state of the editable marker 
list is indicated by a check mark placed next to the last-used format state command, Show 
Marker Char Tags as Text Cmds or Show Marker Char Tags Applied.
As your editing session with an editable marker list progresses, you could see a mixture 
of applied formatting and embedded character commands. This can happen if you start out 
with the list as “Show Marker Char Tags as Text Cmds”, but then selectively add 
formatting. Or, perhaps after selecting Show Marker Char Tags Applied you’ve entered 
embedded commands by hand. Or perhaps either show command has been used on a 
selected portion of the editable marker list and not the entire list.
The new or modified formats will not be forced to the current state indicated by check 
mark in the IXgen menu. You can unify the display whenever you wish by selecting the 
desired formatting command again, even if that command is already checked.
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Show Marker Char Tags as Text Cmds
Convert applied formats to embedded format commands

(Editable Marker List Function)

Purpose: Convert applied character formats to the standard text-based embedded 
character format command syntax used by FrameMaker: <tagname>. 

Method: Search for any applied formatting in the marker text. Get the tag name, 
enclose the tag name in angle brackets, and embed that text into the marker 
text at the start of the formatting. Remove the applied formatting. Where 
appropriate to comply with FrameMaker’s processing rules, insert 
“<Default Para Font>” at the end of the affected text. Insertion of 
<Default Para Font> is not required just before colons, semicolons, 
or at the end of the marker text.

Configuration: No configuration required.

Dialog Settings: Action is immediate. No setup dialog box appears.

NOTE: As part of using Apply Edited Marker List, this function is called 
automatically. (You need not select the command yourself.) This assures that 
all character formatting has been converted to the embedded character 
format command syntax used by FrameMaker.
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Copy Char Catalog to Template
Write current Editable List Char Formats to Edtblist.fm

(Editable Marker List Function)

Purpose: Preserve character format changes and additions made to the current editable 
marker list document by copying them into the template document used by 
Gen Editable Marker List. The template document is: 
<FM_install_folder>\ixgen\templates\edtblist.fm

Method: Each character format in the current editable marker list is copied to the 
edtblist.fm template file. If the character format is not present, it is 
added. If the format is present, the properties are updated (overwritten) with 
the current values from the current editable marker list. The IX document — 
your production index document — is not affected.

Configuration: None required. The copy action is immediate.

Dialog Settings: None.  

Using the Copy Character Formats Function
As you work on the editable marker list and add character formats to support marker 
formatting (and optimize character format display properties to help with editing), you 
will most likely want to save this character tag development. By storing the character 
format updates in edtblist.fm, those refined character tags will be available the next 
time you generate an editable marker list.
Select Copy Char Catalog to Template, or IXgen can automatically copy the formats for 
you during the Apply Edited Marker List operation (page 41). Check “Save Current 
Editable Marker List to ixgen\templates\edtblist.fm” in the apply dialog.

CAUTION: Any same-named character tags already in the edtblist.fm template will 
have their properties updated (overwritten) with the character tag properties 
from same-named tags in the current editable marker list document. If you 
don’t want this to happen, do not use this function or check this box. 
Instead, you can prepare the edtblist.fm template ahead of time using 
the character designer. For general information on marker formatting refer to 
Show Marker Char Tags Applied starting on page 50.
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Capitalization
Control capitalization standards

(Editable Marker List Function)

Purpose: Apply uniform capitalization standards to the markers in a marker list 
created by Gen Editable Marker List (page 33). 

Method: You establish the capitalization standards for each level. IXgen then changes 
the case as dictated by those standards.

Figure 7 Capitalization

Level 1

Level 2

Level 3

Level 4

Leave as is

Initial cap on first word only

aAa Bbb ccC
Aaa bbb ccc

Initial cap on all words Aaa Bbb Ccc

All words in lowercase aaa bbb ccc
All words in uppercase AAA BBB CCC

Up to four levels... With these controls for each level...

animals:wild:lion:mountain ANIMALS:Wild:Lion:mountain

all uppercase

initial caps on first word

as-is

A “level” is recognized by the separation character, a colon ( : )

Initial cap on first word, then as-is
Initial lowercase on first word, then as-is

AaA bBB Ccc
aaA bBB Ccc

Configuration: The illustration above shows how the various control settings affect 
capitalization. Make the desired selections from the dialog box. A different 
capitalization standard can be set for each level, up to four levels. Be sure 
to use Apply Edited Marker List when satisfied with the results of 
Capitalization.

Dialog Settings: Use the diagrams immediately above as a guide in setting the desired 
capitalization standards for each level. Each scroll box for each of the four 
levels provides several different capitalization standards. The description of 
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each listed capitalization standard itself is a sample of the capitalization that 
will take place. 

Text Selection: If you have ranges of markers where you don’t want changes in 
capitalization, you can select just those regions where you want 
capitalization changes to take place.

Tips: • Typically, you’ll want to do most of your other IXgen-related marker list 
processing (Permute Markers, Flip Entries, Create Subentries, Elevate 
Unique Subentries) before setting a capitalization standard. Unless you 
are setting all levels to all lower case, selecting Capitalization early on 
will mean extra work as the other IXgen tools move around words that 
may have varying capitalization.

• Often, you will have exceptions to capitalization rules. The Capitalization 
tool will set the majority of the entries the way you want them, then you 
can make exception capitalization while the marker text is still available 
for editing in the editable marker list. You can do this manually, or by 
selecting an area of text to process in the source document (refer to 
Operational Scope of IXgen Tools starting on page 23). Alternately, you 
can either select only a portion of text in the editable marker list itself 
before using Capitalization, or you can select only a portion of the 
editable marker list prior to selection the Apply Edited Marker List 
function.

• Using the SET button in the Capitalization dialog box only changes the 
capitalization in the editable marker list. The capitalization changes are 
not committed until Apply Edited Marker List is used..
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NOTE: Capitalization properly handles embedded format commands. Regardless of 
the capitalization standard selected, any text found inside angle brackets (< 
or >) is assumed to be a character tag name and is not changed. However, 
if the angle brackets are escaped (\< or \>), the text between such escaped 
angle brackets will be affected.
60 www.fsatools.com 160301 IXgen 7 & 7-10 (for FrameMaker 7 through 15)

www.fsatools.com
www.fsatools.com


Expand Markers IXgen Tool Reference Pages
Expand Markers
Place marker text in main body text

Purpose: Make marker text visible in the current text flow so that markers can be seen 
(and edited) in context. This function is useful for language translators, or 
when certain keywords or phases are to be changed in a document. When 
editing is completed, use Collapse Markers (page 63) to return the marker 
text to actual markers.

Method: Text from markers of the specified marker type is moved into the main text 
flow starting at the point where the marker was found. The marker text is 
assigned a special character tag called IXgenMarker. If the character tag 
IXgenMarker is not already present in the source document, the tag is 
created by IXgen and inserted into the character catalog. (The IXgen default 
properties for IXgenMarker are bold and double-underline.)

The text for the existing marker is changed to placeholder text: 
“!IXGEN_DONT_EDIT_THIS!” This indicates that IXgen has expanded the 
marker. Do not edit this new marker text. When you later Collapse Markers, 
this special marker text is replaced by the collapsed marker text (including 
any edits made to it).

Figure 8 Expanding Markers

Indicates a marker

Move text from marker into the
 text flow. Marker is replaced by
special IXgen marker text.

Configuration: Select the marker type to expand when Expand Markers is invoked.

CAUTION: If you have cross-references linked to paragraphs that also have expanded 
markers in them, do not update these documents until you Collapse Markers 
(page 63). If you have extensive editing to do that will require leaving 
markers expanded across several FrameMaker sessions (or openings and 
closings of the documents being edited), be sure to suppress automatic 
updating. Use Edit>Update References. Select “Suppress Automatic 
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Reference Updating” from the Command button in the dialog box. Check 
each item so that no category of automatic updating occurs. Once you have 
finished editing markers and have collapsed them, you can restore automatic 
updating.

Because Expand Markers adds marker text to the paragraph in which a 
marker is expanded, cross-references that use the body text from such 
paragraphs will include the marker text.

If by chance you do an update while markers were in an expanded state, use 
Collapse Markers. Perform the update again. This should clear marker text 
from cross references.

Dialog Settings: Select the marker type to expand, then click “Expand”.

Tips: • You can change the font attributes of the IXgenMarker character tag if 
you wish. (Use the character designer.)

• Do not place FrameMaker objects, such as variables or anchored frames, 
into expanded marker text. Otherwise, the collapsed marker text will 
divide into multiple markers where the object(s) appears.

• Do not use some other IXgen tool, such as Gen Editable Marker List or 
Apply Edited Marker List, while markers are expanded. Complete current 
operations then Collapse Markers. At that point use other IXgen tools or 
make other edits to your documents.

• Do not attempt to update the file or book while any markers are expanded.
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Collapse Markers
Return expanded marker text to markers

Purpose: Collapse Markers returns the marker text strings inserted into the text flow 
by Expand Markers (page 61) back into their original markers, plus any 
changes in the marker text.

Method: IXgen scans all flows for characters tagged with the IXgenMarker 
character tag. Each segment of text tagged with IXgenMarker is removed 
from the text flow. The text is inserted into the marker located at the leading 
edge of where the tagged text was found.

If no suitable marker precedes IXgenMarker-tagged text, then Collapse 
Markers views the tagged text as “orphaned marker text.” Orphan marker 
text results when you apply the IXgenMarker character tag to text that did 
not originally come from a marker. By applying IXgenMarker character 
tag to new body text you can create what will become new markers during 
the collapse operation.

Using the dialog box, select whether orphaned marker text is skipped over 
(not recommended, unless you explicitly don’t want to save orphan marker 
text), or collapsed into a newly created marker. Also select the marker type 
to create.

Figure 9 Collapsing Markers

Indicates a marker

Move expanded marker text back
into markers. Marker text is removed
from the main body flow.

Configuration: Select the marker type to create if orphan marker text is found.

Dialog Settings: Select the marker type for the collapsed markers. Typically, this is the 
marker type originally expanded. Set “Ignore orphaned marker text” to skip 
over text that may have been tagged with the “IXgenMarker” character tag, 
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but was not originally from a marker. We don’t recommend using this option 
unless you’re sure you want to delete such text.

Tips: If Expand Markers was used, be sure to use Collapse Markers before 
attempting to generate a document derived from markers, such as an index.

Follow these steps to directly add marker text from body text:

1. Set the text insertion point in the source document to the point 
where you want to place the marker

2. Single-click on the IXgenMarker character tag in the FrameMaker 
font catalog

3. Enter the desired marker text

4. Select the paragraph containing the new text

5. Use Collapse Markers with the “Collapse orphaned marker text” 
option selected to create a new marker. Select which marker type 
should be assigned to the new marker.

The above example shows how to do a single marker in a localized area of 
the document. You can repeat steps 1, 2, and 3 several times throughout a 
document. Use step 5 (Collapse Markers) when finished and all expanded 
marker text segments need to be returned to their source markers.
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Markers from Keywords
Generate new markers by searching for keywords

Purpose: Match keywords (or text strings) given in a keyword list. At the starting 
point in the body text where a match is made, a new marker is inserted with 
the keyword text (or text interactively selectable) as the marker text.

Method: Using the template 
<FM_install_folder>ixgen\templates\keyctrl.fm (or a new 
keyword document based on keyctrl.fm), you establish a list of search 
words or phrases. You also establish a companion list of marker text 
alternatives to choose from when a keyword match is made. If you elect not 
to provide alternative companion marker text, the keyword itself is used as 
the marker text.

When using Markers from Keywords on a single document, you can 
interactively decide whether to create markers at matching keywords, and 
also select the marker text to use for the new marker.

You can add new marker text as you go and have the new text automatically 
stored in the keyword document. If you are operating on a book, the 
command operates in batch mode only, creating markers at all matching 
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keywords without any confirmation from you. The first marker text choice 
listed in your keyword document is used for the new marker.

Figure 10 Generating Markers from Keywords
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document.
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Here are the recommended steps to create a keyword control file from the 
template control file provided with IXgen:

1. Use the FrameMaker File>New command. Specify 
<FM_install_folder>\ixgen\templates\keyctrl.fm as 
the template to use.

2. The keyword control file contains a two-column table. In the left-
hand column enter the keywords that IXgen will attempt to match in 
the target document. Place only one keyword in each table cell. 
(Add as many rows as you need.) In the right-hand column, enter up 
to ten1 marker text alternates for each keyword. The alternates must 
be in separate paragraphs and must be in the same cell. Do not 
create separate cells for each alternate. If you want the exact 
keyword text to be entered as the index entry, make no entry in the 
right-hand column for that particular keyword.

1. You can increase this value to extend the depth of the alternate marker text stack. Use Notepad or other 
plain text editor to edit <FM_install_folder>\ixgen\ixgen.ini. See the notes there regarding 
MFKMaxHistory.
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If you wish to establish an index entry with more than one level, use 
standard FrameMaker syntax when building the entry. For example, 
if you have the keyword phrase “mountain lion” one possible marker 
text entry might be “Animals:wild:mountain lion”.

 CAUTION: Do not straddle any cells in the keyword table.

3. When done, save your new keyword control document to a name of 
your choice. (Save as a regular FrameMaker document. Do not save 
as plain text or MIF.)

4. When ready with a selected book or file, select Markers from 
Keywords. Use the file browser to select the keyword document you 
just built, or any other keyword document you might have already 
built.

NOTE: If the marker text contains any of the special characters used for marker 
control (< > ; : [ ]), these characters will be placed into the new 
marker. If this is what you want (for example, you included a control 
function in the new marker text, such as a font change or sort override), this 
is fine. If you want literal values of these characters, then you must escape 
the characters using the backslash in the marker text (\< \> \; \: \[ 
\]).
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Dialog Settings: Each dialog box parameter is explained below.

Keyword File Location Advisory
As a convenience and confirmation that you’re using the desired keyword list, the full 
path to the current keyword file is indicated near the top of the dialog.

Keyword Search Start Point
You can start your search at the beginning of the document, or pick up searching in the 
paragraph where the insert point is currently located. Use “Beginning of document” when 
indexing a document for the first time. Use “...containing the insert point...” if you are 
stopping and starting Markers from Keywords.

NOTE: If you have selected a region of text in the source document, the Keyword 
Search Start Point options are not active. The keyword search will go 
through the entire selected region.
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Create Markers of Type
Select the type of markers to be created. Normally this is index, but you can use other 
types as well. During the generate process FrameMaker can build your index from one or 
more marker types. With this in mind, you can select a marker type other than index (such 
as author or subject) so that you can list only keyword generated markers, if you wish. 
The ability to isolate keyword-generated markers means that you can easily see how to 
refine your keyword list, or even delete just the keyword-generated markers if you don’t 
like the initial results.

Consider Case
The keyword search can be case sensitive or insensitive. Usually you’ll want case 
insensitive matching.

Animate
This option only works on single documents, not books. When selected, the document on 
screen is refreshed to show each successive keyword find. This does slow down the 
process, and much of the document window will be obscured by the keyword dialog box, 
but this option gives you a coarse sense of where you are in the document as the keyword 
search progresses. 

Marker Text
When a keyword match occurs, this text field shows the last-used marker text for this 
keyword. If this is the first find of this keyword, the first line of the marker text for this 
keyword from your keyword file is displayed. If you wish, you can modify the marker 
text immediately, without going back to your keyword document. IXgen will add the 
modification to the marker text list for that keyword; or, you can use the History scroll 
box to select alternate marker text for this keyword.

NOTE: The keyword control file selected when invoking Markers from Keywords is 
updated “live” with any changes you make to the alternate marker text 
selections. If you wish to preserve the original keyword control file, make a 
backup before using Markers from Keywords.

History
Markers from Keywords supports using more than one marker text string for any given 
keyword match. Each time a keyword is found, you can access this list to select a marker 
text variant which best suits the current keyword location and context. The last-selected 
marker text string becomes the default string for the next keyword find, and remains the 
default until another string is selected.

Action Buttons
FIND locates the first (or next) occurrence of a keyword in your document. FIND does 
not insert the marker. Use CREATE or CREATE/FIND to insert the marker at the keyword 
location.
CREATE inserts the marker text displayed in the Marker Text box.
CREATE/FIND inserts the marker text displayed in the Marker Text box and immediately 
resumes the FIND process.
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CREATE ALL switches to batch mode and searches for all keywords in the remainder of 
the document. Interactive capabilities, such as selecting a marker text variant for a given 
keyword match, are no longer available. Once started, the process cannot be interrupted.

Matched
This field shows which keyword has been matched.

Context
This fields shows a few lines of text surrounding the match. This helps you determine if 
you want to make a variant of the marker text for this match, or whether you want to 
place a marker at all. Click FIND to continue searching and not place a marker. Click 
CREATE or CREATE/FIND to place the marker.

Tips: You can use an existing index to create a keyword list. This is useful if you 
already have an index for an existing document, but have created new 
documents with similar content and now need to index them. This process is 
described in Making a Keyword List from An Existing Index on page 80.

Configuration: • Once Markers from Keywords is called from the IXgen menu, select your 
new keyword file when prompted.

• Select the type of marker to be created when a matching keyword is found.

• Markers from Keywords can be used to automatically apply a character 
tag to any matched text in the body text. Notes in the keyctrl.fm 
template document explain how to activate this feature. (This can be 
useful for making active hypertext links out of keyword matches.)

Markers from Keywords has two operational modes: batch and interactive.

1. In interactive mode the keyword search operation suspends whenever 
a match is found. You can then select which one of the alternates 
from your list is appropriate to use as the marker text at that 
location. You can also create an entirely new alternate entry before 
creating the marker.

IXgen keeps the ten most recent alternates in the control list. That is, if you 
modify two of the ten alternates, IXgen will retain the modifications and 
discard two of the least-used alternates. Or, if your initial list had only three 
alternates and during the searching you add two alternates, these would be 
added to the keyword control file currently being used. (As noted in the 
footnote on page 66, you can change how many alternates can be stored by 
IXgen.)

NOTE: The keyword control file selected when invoking Markers 
from Keywords is updated “live” with any changes you make to the 
alternate marker text selections. If you wish to preserve the original 
keyword control file, make a backup before using Markers from 
Keywords.
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2. Batch mode means that IXgen will automatically go through the 
target file(s) and insert marker text when a keyword is found. If the 
matched keyword has multiple alternatives listed, the first alternative 
is used as the marker text. If no alternatives are listed, the keyword 
itself is used as the marker text.

NOTE: Batch mode is the only mode available when processing books. Batch or 
interactive mode can be used when working on an individual file.

Tips: If running in batch mode on a single document and you want the process to 
run faster, minimize the document just before selecting Markers from 
Keywords.
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Markers from Paragraph Tags
Generate new markers from selected paragraph tags

Purpose: Markers from Paragraph Tags provides an excellent way to introduce a 
starting base of markers into a new document. The text from selected 
paragraph tags is copied into new markers. Selected paragraph tag types are 
usually chapter and subsequent headings, but you can select any tag type 
you wish.

Method: The document is scanned for the selected paragraph tag(s). When found, the 
paratext from the paragraph is copied into a new marker of the selected type. 
The marker is placed at the head of the paragraph.

Figure 11 Generating Markers from Paragraph Tags

Indicates a marker

Copy paratext from selected tags
into newly created markers of the
desired marker type
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Dialog Settings: Select the type of marker to create; double-click in the scroll lists to select 
one or more tags whose text will be inserted in new marker at the start of 
tagged paragraph.

Tips: In some instances, the raw text captured from first or second level heads will 
not make an ideal index marker. You will want to use other IXgen tools, 
such as Permute (rotate) marker text or Create Subentries, to enrich the 
markers created with Markers from Paragraph Tags. You can use Gen 
Editable Marker List or Expand Markers to give a better view for fine-
tuning the markers you’ve created. In particular, once a Gen Editable Marker 
List has been generated, try permuting the markers. Refer to Using the 
Permute (Rotate) Marker Text Function starting on page 39.

NOTE: If the source paragraph text to be placed in the new marker contains any of 
the special characters used for marker control (< > ; : [ ]), these 
characters will be placed into the new marker, and likely will not be 
interpreted as you intend. You will probably want literal values of these 
characters. To do this, you must escape the characters using the backslash in 
the marker text (\< \> \; \: \[ \]).

Generally, it is unlikely that paragraph text used for index entries will 
contain such characters, but if does, we suggest using a different marker 
type. This way, you can collect just those markers in a Gen Editable Marker 
List operation, and then perform a find/change operation to include the “\” 
escape command with any of these special characters.
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Markers from Character Tags
Generate new markers from selected character tags

Purpose: Markers from Character Tags generates new markers based on text 
formatted by an applied character format. In this way, you can automatically 
index each occurrence of any special term or phrase which has been 
emphasized by a specific character tag.

Method: The document is scanned for text where the selected character tags have 
been applied. When found, the character tagged text is copied into a new 
marker of the selected type. The new marker is placed at the start of the 
tagged text.

Figure 12 Generating Markers from Character Tags

Indicates a marker
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Dialog Settings: Select the type of marker to be created when a matching tagged character text 
is found. Double-click the lists to select the name(s) of the character tag(s) to 
locate. 

Text Selection: You may find a number of unwanted markers generated from character 
tagged text. For example, you may only wish to index a special term the first 
time it appears, or where an index entry would be meaningful, but not at 
every incidental occurrence of text with the applied format.

When using Markers from Character Tags, use a text selection to limit the 
area processed. You can also use Gen Editable Marker List or Expand 
Markers to view and delete unwanted markers.

Tips: Dedicating a marker type just to markers created from character tags can be 
very helpful in monitoring how many markers are created, and then 
maintaining those markers.

NOTE: If the source character tag text to be placed in the new marker contains any 
of the special characters used for marker control (< > ; : [ ]), these 
characters will be placed into the new marker, and likely will not be 
interpreted as you intend. You will probably want literal values of these 
characters. To do this, you must escape the characters using the backslash in 
the marker text (\< \> \; \: \[ \]).

Generally, it is unlikely that character-tagged text used for index entries will 
contain such characters, but if it does, we suggest using a different marker 
type (as suggested in the “tip” just above). This way, you can collect just 
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those markers in a Gen Editable Marker List operation, and then perform a 
find/change operation to escape any of these special characters.
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Delete Redundant Markers
Remove back-to-back markers that are duplicates

Purpose: Duplicate markers that are back-to-back serve no purpose and can be safely 
eliminated. While this will save some modest amount of document overhead, 
the main purpose is to streamline future marker maintenance. (Duplicate 
markers can occur if IXgen tools such as Markers from Paragraph Tags or 
Markers from Character Tags are used repeatedly on the same document. 
Markers from Keywords can also cause duplicate markers if the same 
keyword list is used more than once on the same document.)

Method: When a marker is located, Delete Redundant Markers checks to see if 
another marker immediately follows, with no intervening text. If the next 
marker is an exact duplicate in all ways — marker type, marker text, marker 
text formatting, even case — the redundant marker is removed. If additional 
redundant markers also immediately follow, they too are removed.

NOTE: Duplicate markers separated by any intervening text are not considered 
redundant and are not removed. Such markers have real utility in identifying 
a second occurrence of an item that should be indexed wherever it occurs, 
or requires its own entry. This is particularly important if the intervening 
text includes one or more page breaks.

Figure 13 Deleting Redundant Markers

Indicates a marker
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Configuration: None required.
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Suggested IXgen Uses (Cookbook)
This section provides a “cookbook” for many common indexing tasks that can be done 
with IXgen. If you have any doubt as to the function of an IXgen tool noted here, review 
the section describing that tool. (If reading this document in PDF form, each term is an 
active link and you can jump to the tool description.)

Making an Index from Scratch
These steps are suggested for making an index from scratch:

1. Use Markers from Paragraph Tags to generate a starting index. Typically, first, 
second, and sometimes third-level heads are used to create a base index. You can 
also supply a keyword list and use Markers from Keywords to generate a 
starting list. If you have special names or terms emphasized by a character tag, 
you can also use Markers from Character Tags.

2. Use Gen Editable Marker List to generate an alphabetic list of markers the 
markers created.

3. Use Apply Edited Marker List and select the Permute Markers option in the 
apply dialog box to expand the base set of markers created in step 1. Discard the 
editable marker list document without saving; it was just applied and the markers 
are now back in the source document(s).

4. Use Gen Editable Marker List again to generate an alphabetic list of markers so 
that you can get a feel for what has been created from using Permute Markers.

5. Manipulate the markers as desired within the list created by Gen Editable Marker 
List. You can use find and change along with spell checking the entries.

6. The Gen Editable Marker List function also supports several additional editing 
features: Use Create Subentries to check for entries that could made more 
readable by establishing a single main heading and several subheadings. In 
several cases a swap of the first and second level entries may be useful. Try Flip 
Entries. Once comfortable with the Flip Entries settings, use Speed Flip to 
immediately perform flip operations. If you have any reference entries, use 
Validate References to check them. Use Elevate Unique Subentries to clean up 
any first-level entries that have only one subentry.

7. Use Apply Edited Marker List to reflect changes made in prior steps back to the 
source markers. Again, discard the document once the markers have been 
applied.

8. Generate/update the FrameMaker book to get a fresh IX document showing all 
your marker edits. Review the index; repeat any of the steps above to get the 
kind of index you want. Be sure to repeat Generate/update as the last task of 
your index creation.
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Maintaining an Index While Maintaining the Main Text
Maintaining an index in parallel with main text maintenance can have several facets, 
depending on edits you plan for the main text body. Where appropriate, main body text 
changes should also be reflected in the companion markers, . Such changes could be made 
with find and change, the spelling checker, or even by hand as you review a document.
Use Expand Markers before starting your maintenance edits on the main body text. This 
way, any updates you might make using find and change, such as changing a product or 
function name, will automatically affect the text of the expanded markers.
While reviewing text for other content or style changes, you will also be able to 
immediately see any markers that might need to be changed.
When editing is finished, be sure to use Collapse Markers to return marker text that was 
in the main body to the source markers.

Working with Small Pieces of an Index
You sometimes only wish to work with a small chunk of text for marker management 
purposes. For example, say you added 3-5 pages of new material to an existing document. 
Rather than IXgen manipulating all pages of the file or book (and thus all markers), you 
can select the area IXgen is to work with. Selecting an area “scopes” IXgen functions to 
just that selected area (refer to Operational Scope of IXgen Tools on page 23).
In many instances you’ll need to work on a cluster of markers bunched together at the 
beginning of, say, a first or second level heading line. Getting to each marker using the 
FrameMaker marker window can be tedious.
IXgen can make marker access much simpler. Simply select the area of text (or line of 
text) where the markers reside. Then use Gen Editable Marker List or Expand Markers to 
see and edit all the markers clustered together in that one area.

Converting from one Marker Type to Another
IXgen can convert from one marker type to another:

1. Generate an editable marker list using Gen Editable Marker List.

2. Within the editable marker list, use Find/Change to search for the text of the 
marker type name and replace with the text of the new name.

You can use any marker name you choose, either those currently defined, or new 
types that you define. To see the available marker types (and their exact names), 
use FrameMaker>Special>Marker to bring up the Marker dialog box. Select a 
listed marker type from the Marker Type scroll box, or define a new marker type 
by selecting Edit... from the Marker Type scroll box. Be sure the marker type is 
defined before attempting the marker type conversion.  
 
(The intent is not to select a marker type from the FrameMaker Marker dialog, 
but rather use it as a viewer of current marker types, and as a way to define a 
new marker type, if desired.)  
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In the Change field, be sure to specify the new marker type exactly as it appears 
for that marker type.

NOTE: Marker names are case sensitive. Emphasis is not the same as emphasis. 
These indicate two different marker types.

3. When the marker types have been changed as desired, apply the edited marker 
list using Apply Edited Marker List.

Remember, you can do this globally to all the selected documents in a book file, globally 
to a single document, or locally to a selected area within a document.
And remember: once you change a marker type, the new type might not be listed in a 
particular generate activity that you’ll do with FrameMaker. This might be your intent; 
otherwise, you’ll probably want to add the marker type to the setup list for a given marker 
collection.

Making a Keyword List from An Existing Index
Once an index is created, that index can be a useful keyword source when indexing 
content-related documents that you create at a later date, or that are currently lacking an 
index. Using an existing index as a keyword source can be especially valuable if your 
target document has special phrases or terms not typically found in headings (and thus 
would not be picked up by Markers from Paragraph Tags).

1. Open a NEW document using the IXgen template document keyctrl.fm as the 
template file.

2. Collect a raw keyword list from existing indexed material. This can be done in 
two ways:

Method 1: Generate a special index document that has no page numbers. After an 
initial generate operation, change the <$pagenum> controls on the generated 
document reference page to <$nopage> and generate again. Select some or all 
of the entries and convert them to a single column table, one original paragraph 
per new table cell (use “Convert to table” in the Table menu). Add one empty 
column to the right so that you have a two-column table. Copy and paste the 
table into the NEW document created in step 1, replacing the current table in the 
NEW document.

Alternate Method 2: Use Gen Editable Marker List on the source document or 
book and generate a marker list. Copy and paste the column with the marker text 
into the document created in step 1, replacing the current table in the NEW 
document. Add one empty column to the right so that you have a two-column 
table. 

3. Edit the new keyword table as needed; place alternate marker text in the right-
hand column as desired. If no text appears in a right-hand column, the keyword 
is used as the marker text. If appropriate, rearrange and add keywords to catch 
items that may not have a direct match in the text to be indexed.
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If you have an index entry more than one level deep, use the lowest level as the 
keyword and build the marker text from the complete entry. For example, here’s 
how to convert two multiple-level index entries into keywords and marker text:

Keyword Marker text

mountain lion Animals:wild:mountain lions

zebra Animals:wild:zebra

Animals 
 wild 
  mountain lions 
  zebras 
  

 CAUTION: Do not straddle any cells in the keyword table.

4. Save the NEW document to any name you’d like.

5. Open the target book or document. Select Markers from Keywords. Select the 
keyword file you just saved, and run Markers from Keywords as you normally 
would.

By building a keyword file from an existing index for similar material, future indexes 
created from such a keyword file will create an index more uniform with your existing 
indexes. When editing the keyword list, don’t forget to include items unique to the new 
document. Of course, you can create and use as many keyword files as needed to 
represent various kinds of documents.

Deleting all the Markers of a Given Type
From time to time you may find it easier to simply delete markers and start over rather 
than modify them. This can be the case if you’re doing a “make-from” to create a new 
document from an existing document. Perhaps you’re documenting a new product and 
using a current product document set as a starting point. Some or all of the markers may 
be invalid for the new product.
Clearing out the old markers using either the FrameMaker find/change function or the 
marker window can be quite tedious. Instead, create a Gen Editable Marker List. Delete 
some or all of the text entries from the column labeled “Edit Marker Text in this 
Column”.

CAUTION: Do NOT delete rows or cells from the table, merely the text in the marker 
text cell. (Leave the empty cell in place.)

You can do wholesale deletions from the editable marker list by selecting the table cells 
holding the marker text to be deleted, then selecting Edit>Cut>Leave cells empty. You can 
delete ALL markers by selecting the entire marker text column in the table before the cut 
operation. Delete cell contents only! Do not remove columns or rows from the table.)
When the desired marker text cells are empty, use Apply Edited Marker List to “apply” 
the deletions to the source document(s).

Generating HyperText Pop-ups
Suppose you have a list of special terms for a document that is to go on-line as a 
FrameMaker locked (view only) document. Whenever one of these special terms appears 
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in the document, you want your users to click on the term and get a pop-up definition. 
IXgen could automatically insert these pop-ups for you. Here’s how.

1. Edit a new document using keyctrl.fm as a template document. In the box 
titled “Enabling Character Tagging on Matched Keyword Text” select a small 
portion of text. Press F8. Start typing “HyperText” until the character format 
“HyperText” is selected. Press enter. This will apply the hypertext format to 
some of the text, which will signal character tagging of the matched keywords.

2. In the table starting in the lower portion of the first page, add rows as needed 
to accommodate the keywords you plan to use. In each left-column cell, enter a 
keyword. In the companion right-column cell, enter the word “alert” followed by 
a space followed by the text that will define the term. Remember that 
FrameMaker imposes a 255 character limit on the length of a marker. Save and 
exit the keyword document.

3. Go to the source book or document, select Markers from Keywords from the 
IXgen menu. Enter the name of the keyword document you just built; select 
“hypertext” as the marker type to generate. Click FIND/CREATE as desired, or, 
if you wish, click “CREATE ALL”.

4. Lock the modified source document by pressing ESC F l k (uppercase “F” with 
no spaces). Save the document.

Assuming you’ve used the default character tag provided (“HyperText”), any matched 
keywords should be blue and underlined. Click on one of these to bring up a pop-up 
ALERT box which will contain the definition you supplied in the keyword list document.

Generating HyperText Links to other Documents
Suppose you have a list of special phrases for a document that is to go on-line. Whenever 
one of these special phrases appears in the document, you want your users to be able to 
click and go to some other document. IXgen can automatically insert these hypertext 
linkages for you. Here’s how.

1. Edit a new document using the IXgen template file keyctrl as a template 
document. In the box titled “Enabling Character Tagging on Matched Keyword 
Text” select a small portion of text. Press F8. Start typing “HyperText” until the 
character format “HyperText” is selected. Press enter. This will apply the 
hypertext format to some of the text, which will signal character tagging of the 
matched keywords.

2. In the table starting in the lower portion of the first page, add rows as needed 
to accommodate the keyword phrases you plan to link. In each left-column cell, 
enter a keyword phrase. In the companion right-column cell, enter the word 
“openlink” (or “gotolink”) followed by a space followed by the document name, 
search information, or page number. Refer to the hypertext marker syntax 
definitions in the FrameMaker manual as needed.
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3. Go to the source book or document, select Markers from Keywords in the IXgen 
menu. Enter the name of the keyword file you just built; select “hypertext” as 
the marker type to generate. Click FIND/CREATE as desired, or, if you wish, 
click “CREATE ALL”.

4. Lock the document by pressing ESC F l k (uppercase “F” with no spaces). Save 
the document.

Assuming you’ve used the default character tag provided (“HyperText”), any matched 
keywords should be blue and underlined. Click on one of these to jump to the specified 
document and location in that document. If this does not work properly, be sure that 
you’ve used the proper syntax in defining the jump, and that the destination document 
exists. You can use Gen Editable Marker List to collect hypertext markers. (Make sure 
that only hypertext markers are selected as the type of marker to find.) Verify and if 
needed fix the hypertext marker text. (IXgen can help you place the marker and its 
content; but IXgen can’t check hypertext command syntax for you.)

How the Index for this Manual was Created

The index for this document is a good working example of how IXgen can be used to 
create an index. This index took minimal time to create and polish. While a small 
document with a simple index, the steps noted here could run into several days using the 
conventional marker window approach. Here are the steps we used:

1. This document was a “make from” one of our other product manuals. First, we 
cleared existing index markers using Gen Editable Marker List. All markers were 
deleted from the source documents by selecting the “edit marker text” column of 
the editable marker list, then selecting Edit>Cut>leave cells empty. The marker 
deletions were then “applied” using Apply Edited Marker List.

2. Markers from Paragraph Tags generated a starting list of new markers from the 
first and second heads, along with a few other tag types.

3. Gen Editable Marker List was used again to see the new set of markers just 
created. Some adjustments were made; some new entries were added to existing 
markers using FrameMaker’s semicolon separator for index entries. Apply Edited 
Marker List applied the changes to the source markers. Permute Markers was 
selected during the apply operation.

4. From the FrameMaker book we did another generate/update to see the new index 
document created by FrameMaker. We saw some additional changes to make. 
Gen Editable Marker List was again used to get the editable marker list, as this 
is a very easy way to get to marker text, even for the simplest updates.

5. In reviewing the index entries, we performed a number of level permutes using 
Flip Entries set to “copy and flip”. This would give readers another way to find a 
topic of interest.
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6. Toward the end of the final editing process, we made one more pass with Gen 
Editable Marker List. This time we finalized Capitalization. We also ran Validate 
References to check the references made in the index.

7. We decided to index table and figure titles. Markers from Paragraph Tags was 
used again to collect the titles, but this time we used subject markers for tables 
and author markers for figures. This was done so that we’d be able to separate 
these markers from index markers, if we needed to. Gen Editable Marker List 
collected the markers inserted by Markers from Paragraph Tags. Suffixing the 
strings “(table)” and “(figure)” was then easily done while these markers 
were in the editable list form. Apply Edited Marker List updated the markers 
once again. In the book set up file for the index, subject and author markers 
were added to the list of marker types to collect for the index. A final 
generate/update was made from the book level.

8. When this manual was updated for IXgen 7, a number of new sections were 
added, and numerous maintenance edits were made. The index was extensively 
enhanced making use of several new IXgen tools.

• Create Subentries created main entries and subentries at a number of different 
entry clusters, making the entries more readable.

• Elevate Unique Subentries found those lone entry/subentry markers and made 
them a single line in the index (where appropriate; we kept a few for emphasis 
and readability).

• Flip Entries made additional locators.
• Show Marker Char Tags as Text Cmds and Show Marker Char Tags Applied 

helped visualize the character formatting used in the index. We added a 
number of formatting additions, as formatting can help with overall readability 
of the index.

• Validate References found a few typographical errors in the reference text 
made inside the index. Once identified, the errors were easy to correct.

The ability to work on a small area of selected text was used extensively. One 
collection of all the markers via Gen Editable Marker List was done and the 
markers were reviewed in the context of a sorted list. A number of minor 
corrections and updates were done. A few rearrangements of first and second level 
entries was quickly done before the final Apply Edited Marker List.
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Many common problems are identified in this section. If you need additional help, please 
email franks@fsatools.com or call 1-435-275-8981.
Before you email or call, please be prepared to tell us about your situation:

• system (operating system, revision level, memory installed, virtual memory 
settings);

• exact version of FrameMaker (use Help>About FrameMaker then click the More 
button; look for a detailed version number);

• nature of the problem (what you were doing and how you got there, and the error 
or problem that occurred — be sure to check the items noted in Table 3, 
“Installation Problem Summary,” starting on page 86 or Table 4, “Operational 
Problem Summary,” starting on page 89).

If you are having an operational issue with IXgen, we’ll also need to know:
• whether the problem just started or has always been present, whether the problem 

appears on other, similar files. If the problem just started, think back to any recent 
changes to your system — new hardware, software, network changes, and so on.

• If the problem is an intermittent crash or a feature that stopped working, have you 
tried not only rebooting but actually turning off your system for at least five 
minutes? Sometimes memory does not fully clear from a reboot; only an extended 
power-off period of several minutes will clear memory.

We’ll get back to you as soon as possible (usually one business day), but certainly within 
the time limits noted in our warranty (page 97).
We are pleased with the outstanding performance of IXgen during its 17 years of release, 
and we want to keep that reputation in place. If you run into a problem, we want to get 
a resolution for you as soon as possible
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Installation Errors
The errors described in this section might occur during installation.

Table 3 Installation Problem Summary

No. Description Page

The link for the IXgen download on the fsatools.com website 
appears inactive 86

Nothing happens when clicking the self-extracting zip file 86

Files can’t be copied, executed, opened, or moved 87

IXgen seems to have installed, but the system key field in 
IXgen>License dialog box shows “Error 67”. 87

IXgen seems to have installed, but the system key field in the 
IXgen>License dialog box shows “Error 14”. 87

IXgen seems to have installed, but the system key field in the 
IXgen>License dialog box is empty or shows “not available”. 88

IXgen seems to have installed, but the password field in the 
IXgen>License will not accept the password sent to us. 88

Some other error number occurs not listed above. 88

Problem 1: The link for the IXgen download on the fsatools.com website 
appears inactive.

Solution: This is likely a security setting with your web browser. Please check 
your settings, or try the download on another computer.

Problem 2: Nothing happens when clicking the self-extracting zip file

Solution:  Your system security will not accept zip extractions. You will need to 
change the appropriate security setting, or have your I.T. support person 
change this for you. You could also extract the distribution in a scratch 
folder on a different machine, then copy that folder and its freshly 
unzipped contents to the system where you wish to install and use IXgen. 
Once the files are on that system, you can install IXgen as described in 
Installing IXgen starting on page 11.  
 

 For IXgen 7-10 users, try the zip version of the distribution rather 
then the self-extracting (.exe) version. Be sure to manually extract the 
zip before continuing with your IXgen installation. Do not attempt to run 
the installation from within the zip folder.

1

2

3

4

5

6

7

8
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 The file might be corrupt. Delete it, and try another download. (Wait 
a few moments between downloads.)

Problem 3: Files can’t be copied, executed, opened, or moved

Solution:  Your system security will not accept file system changes. You will 
need to change the appropriate security setting, or have your I.T. support 
person change this for you

 If you are using Windows 7 or Vista, be sure to minimize or disable 
UAC.

Problem 4: IXgen seems to be installed, but the system key field in IXgen>License 
dialog box shows “Error 67”, “unavailable” or is blank. 

Solution:  While doing licensing functions with IXgen, be sure to right-click on 
framemaker.exe (in the FrameMaker installation folder) and select “Run 
as Administrator.” If you are using Windows 7 or Vista, be sure to 
minimize or disable UAC. One licensing has concluded, you can start 
FrameMaker as you usually do.

 Be sure to install IXgen using the login you will use with IXgen and 
FrameMaker on a regular basis. Do not install IXgen using some other 
account.

Problem 5: IXgen seems to be installed, but the status field in the IXgen>License 
dialog box shows “Error 14” after the password was input and “Update 
Password” was pressed..

Solution: This usually means that the current IXgen password is either missing 
dashes in the character groupings, or zeros were input as uppercase Os.

Never transcribe (keyboard) a password that you send you, alway copy 
the password from the email and paste it into the password field.

To fix this problem so that a clean ixgenkey.999 file can be regenerated, 
place the following string in the "Current Password" box in the IXgen 
licensing dialog box (select IXGEN>LICENSE):

   AAAA-2222-CCCC

Select "update password".

While this password will still be invalid, the internals of the system key 
and password receiver have been cleared and reformatted. The above 
actions will put a new system key in the ixgenkey.999 file. Please send 
that revised system key to us. You can copy the system key directly from 
the license dialog box and paste it into and email to us 
(franks@fsatools.com)
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Problem 6: IXgen seems to be installed, but the system key field in the 
IXgen>License dialog box is empty or shows “not available”.

Solution: This is the same as “Problem 4: on page 87. Try the solutions listed 
there.

Problem 7: IXgen seems to have installed, but the password field in the 
IXgen>License will not accept the password sent to us.

Solution: It’s likely that some or all of the files or folders in the ixgen folder that 
appears in the home folder of the FrameMaker installation do not have 
the proper access permissions or settings. If you’re not sure how to do 
this, please contact your I.T. department.

Problem 8: An error has occurred that is beyond the scope of this manual.

Solution: Please contact us at franks@fsatools.com, or 1-435-275-8981.
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Operational Errors
The errors described in this section might occur as you use IXgen.

Table 4 Operational Problem Summary

No. Description Page

An editable marker list is created, but no markers are listed 89

Gen Editable Marker List is missing some markers. 90

Too many Gen Editable Marker List files are open, and none of the 
files are named! 90

Some or all of the changes made in a Gen Editable Marker List 
document did not get transferred back to the source document(s) 91

!IXGEN_DON’T_EDIT_THIS! appears in the index document. 92

Marker text suddenly appears in cross references 92

Various template documents are too large for the display 92

All the files in the book are open and minimized, but an IXgen operation, 
such as Markers from Keywords, asks again for files to be opened 93

Generate Editable Marker List or other IXgen function fails 94

Several IXgen tools are missing from the pull-down menu! 95

Marker text formatting does not appear to be evenly applied in the 
editable marker list. 95

IXgen does not appear in the FrameMaker menu bar. 96

Special characters have been replaced by question marks 96

Problem 9: An editable marker list is created, but no markers are listed

Solution:  Check that you didn’t inadvertently make a very small selection in the 
source document. Remember, when working within a single file, IXgen 
will only process the selected area, if a text selection is present. Refer to 
Operational Scope of IXgen Tools on page 23. You can also adjust the 
MinCharsInTextSelection parameter in the 
<FM_install_folder>\ixgen\ixgen.ini file. (Refer to the 
notes in ixgen.ini about this parameter.)

 Be sure the insert point is present in the desired source document.

 Be sure you selected a marker type that is actually in the source 
document.

9

10

11

12

13

14

15

16

17

18

19

20

21
160301 IXgen 7 & 7-10 (for FrameMaker 7 through 15) www.fsatools.com 89

www.fsatools.com
www.fsatools.com


Problems and Solutions
Problem 10: Gen Editable Marker List is missing some markers.

Solution:  Is a text selection present in the source document? Marker collection 
will be limited to the selected area, if a text selection is present (refer to 
Operational Scope of IXgen Tools starting on page 23 for more details). 
You can also adjust the MinCharsInTextSelection parameter in 
the <FM_install_folder>\ixgen\ixgen.ini file. (Refer to the 
notes in ixgen.ini about this parameter.)

 If generating a Gen Editable Marker List from the book file, be sure 
that all the desired files have been selected and are minimized (review 
the book file topics starting on page 24).

 Be sure you selected all the different type of markers that were used 
for index entries in the source document.

 Remember, Gen Editable Marker List is normally used with sorting 
active. Did you use the semicolon syntax so that you can have multiple 
index entries per marker? If so, perhaps the entry that seems to be 
missing is actually part of another marker located elsewhere in the list 
due to the marker sorting. Try using the Edit>Find/Change command to 
look for the missing entry. When you apply the edited marker list, 
consider using Split multiple index entries into separate markers.

Problem 11: Too many Gen Editable Marker List document windows are open, and 
none of the documents are named!

Solution: Every time you use Gen Editable Marker List, a document is created and 
a document window opened. For most situations, this is a transient, 
“throw-away” document that never needs to be saved once Apply Edited 
Marker List has been used. You use the document as a collection point for 
your marker text. You edit that text, then apply the changes back to the 
source markers using Apply Edited Marker List.

At this point, the Gen Editable Marker List document no longer has any 
value and should be discarded. (Quit or close the file, and answer “NO” 
when prompted to save the file. Or, Control-Alt-click the DISCARD 
button as soon as you’re through.) Because of this typical short-term 
usage, IXgen does not automatically assign a file name.

If you saved the document so that you could come back later and finish 
editing the markers, or saved the document to protect work done so far, 
delete the file once marker editing has concluded and the changes have 
been applied to the source document(s) using Apply Edited Marker List.

Remember, once the edited marker text is applied back to the source 
markers using Apply Edited Marker List, the information is safe in the 
source markers. Keeping the editable marker list file beyond this point 
serves no purpose.
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Problem 12: Some or all of the changes made in a Gen Editable Marker List document 
did not get transferred back to the source document(s)

Solution:  Application of the text can be limited to the text selected in the 
editable marker list document when Apply Edited Marker List is used. 
Make sure you didn’t have a small text selection in effect when Apply 
Edited Marker List was used. Click once to set an insert point in the 
editable marker list document to remove any text selections, then try 
Apply Edited Marker List again. You can also adjust the 
MinCharsInTextSelection parameter in the 
<FM_install_folder>\ixgen\ixgen.ini file. (Refer to the 
notes in ixgen.ini about this parameter.)

 How are you viewing the results of an Apply Edited Marker List 
operation? If you’re looking at a FrameMaker generated list, such as an 
“IX” file, did you regenerate the file(s)? If you’re looking at the 
document created by a second run of Gen Editable Marker List, did you 
select the correct marker type to collect?

 Because IXgen makes marker generation so simple, it is possible to 
inadvertently create marker entries of an unintended type, such as 
Glossary instead of Index. Make sure you are editing and reviewing the 
correct marker type.

 At some point you made edits in the source document(s) after creating 
an editable marker list but before applying the list. Due to a bug in 
FrameMaker, source file edits can cause internal marker ID numbers to 
renumber such that IXgen can no longer properly identify source 
markers. When this happens, the apply will not be completed.  
 
Assuming the direct changes were not substantial, you can save the 
current editable marker list to a new file name and then generate another 
editable marker list. This new list will have the old marker text you 
started with, but internal marker ID values will be up-to-date.  
 
Set your display so that you can see the marker text column of both lists 
side-by-side. Verify that the marker entries are in synchronization, either 
as a complete list or in blocks of markers. Copy (control-C) from the 
marker list you edited as many of the marker text cells as you can. (Copy 
the cells only, not entire rows.) Select a corresponding block of marker 
text cells in the just-generated editable marker list. Paste (control-v) to 
overwrite the marker text cells in the new list. Repeat this process for 
each corresponding block of markers that you see.

When you have completed transferring the markers, Use Apply Edited 
Marker List on the list just created. The markers should now apply 
properly and reflect your editing work.
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Problem 13: IXGEN_DON’T_EDIT_THIS!” appears in the index document.

Solution: At some point you used Expand Markers but never used Collapse 
Markers to return expanded marker text to the original markers. Or, you 
did use Collapse Markers, but at some point prior to the collapse 
operation the character tag used by IXgen to identify expanded markers, 
IXgenMarker, had been removed from some or all expanded marker 
text.

 Use Collapse Markers to be sure all markers are properly collapsed. 
Regenerate the FrameMaker index. If some or all the warning text still 
appears, try the next solution:

 Use Gen Editable Marker List to collect all current markers. Search 
for the text !IXGEN_DON’T_EDIT_THIS! in the editable list. Use the 
Navigate column to jump back to the source page. See if you can locate 
what appears to be marker text still in the body text. Cut the text and 
return to the editable marker list. Paste the cut text into the marker text 
column such that the !IXGEN_DON’T_EDIT_THIS! text is replaced. 
Repeat for each instance of !IXGEN_DON’T_EDIT_THIS!. Use the 
Apply Edited Marker List function, then regenerate the index.

If no apparent marker text is seen in the source document(s) return to the 
editable marker list document and delete the 
!IXGEN_DON’T_EDIT_THIS! from the marker text cell. Leave the cell 
empty. Use Apply Edited Marker List, then regenerate the index.

NOTE: Because untagged, elevated marker text may be difficult to see, also try 
spell-checking the page. The spell check will likely catch a nonsense “word” 
formed at the point where regular body text and elevated marker text meet.

Problem 14: Marker text suddenly appears in cross references

Solution: You performed an update, either locally to a single document or from the 
book, while markers were in an expanded state (Expand Markers had 
been used). Use Collapse Markers on all affected source documents, then 
update again. This should clear marker text from cross references. For 
more information, refer to the cautionary note starting on page 33.

Problem 15: Various Template documents are too large for the display.

Solution: The IXgen template files are designed for full-page displays. If you are 
running a lap-top or partial-page display, this may be inconvenient. You 
are welcome to modify the template files to best fit your work 
environment. Go to:  
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<FM_install_folder>\ixgen\templates  
The IXgen template files are:

IXgen Template Files 
(ixgen\templates)

Bkctrl.fm

Edtblist.fm

Keyctrl.fm

Permctrl.fm

Report.fm

Valrefctrl.fm

Valreport.fm

Make back-up copies of these files before continuing. Use the Format>Page 
Layout>Page Size dialog to make page size changes from within 
FrameMaker.

Problem 16: All the files in the book are open and minimized, but an IXgen operation, 
such as Markers from Keywords, asks again for files to be opened.

Solution: This is a very rare problem, caused by as yet unidentified problems in 
FrameMaker itself. This symptom can indicate one or more corrupt 
FrameMaker files in the book, including the book file itself. Internally, 
an improper or unexpected break in the flow has most likely occurred. 
This corruption is difficult to trace, but has been associated with 
FrameMaker documents that have been heavily edited over time, have 
been upgraded from earlier versions, or were converted to FrameMaker 
from a word-processing format.

To remedy the problem first isolate the offending file(s). Do this by 
closing any currently open or minimized files. Leave the book file open. 
Then, in the book file, use the IXgen>Select Files option to select and 
open the first half of the files listed in the book. Try the IXgen function 
that originally caused the redundant open message. If the extra prompt to 
open files no longer occurs, then the corrupt file is in the other group.

Again, close all files but the book file. This time, open half of the files 
in the remaining half (a quarter of the files). Again try the IXgen 
function that caused the redundant open message. Repeat this halving of 
the file groups until you find the file causing the redundant open 
message. Note the file. Continue with the remaining files to be sure that 
another file is not also corrupt.
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To also verify that the corruption is not elsewhere, again close all files 
except the book file. In the IXgen Select Files dialog, select all files 
except the file(s) identified as corrupt. File opening should now occur 
without the redundant message.

You can attempt to repair the corrupt files using one of these methods: 
(a) save the file to MIF and reopen. (b) rebuild the file by opening a new, 
custom file (do not use a template). Copy and paste the body text flow 
contents from the corrupt file into this new file. Next, use 
File>Import>Formats to bring across all formats from the corrupt file to 
the new file. These actions rebuild internal structures and usually correct 
the corruption. Importing formats from the corrupt document does not 
seem to be a problem, but you can use another similar document from 
your file set to supply formats if you wish.

If the problem persists, the problem is in the book file. You will need to 
discard the current book and file and create a new book file from scratch. 
(Rename the old book file rather than deleting it. This way, you can refer 
to various configuration items, if necessary.)

Problem 17: Generate Editable Marker List or other IXgen function fails

Solution:  This usually indicates an underlying system problem. In almost all 
cases this turns out to be that the IXgen template in use for a particular 
IXgen tool has fonts not recognized in the printer driver you currently 
have attached.

Try opening 
<FM_install_folder>\ixgen\templates\edtblist.fm. If 
you see errors on opening, such as font substitutions, let the file open. 
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Take a quick look at the document. If the text seems readable, all is well 
and you can save the document.

Solution: If you see a file open error, open and save each file as noted in the table 
below:

IXgen Template Files 
(ixgen\templates)

Bkctrl.fm

Edtblist.fm

Keyctrl.fm

Permctrl.fm

Report.fm

Valrefctrl.fm

Valreport.fm

If you want to change fonts in the template files, or want more 
information about changing fonts, review Additional Notes about IXgen 
for Windows starting on page 5 and Changing Fonts Used by IXgen 
starting on page 17.

Problem 18: Several IXgen tools are missing from the pull-down menu!

Solution: You are looking at the book-file version of the IXgen menu. This version 
does not include several functions that can only be used on a document 
created by the Gen Editable Marker List function, including Permute 
Markers, Create Subentries, Elevate Unique Subentries, Validate 
References, Split multiple index entries into separate markers, Show 
Marker Char Tags Applied, Show Marker Char Tags as Text Cmds, and 
Capitalization.

Select Gen Editable Marker List, then select the IXgen pull-down menu 
from the document just created by Gen Editable Marker List. The 
additional IXgen tools will be seen now and can be used.

Problem 19: Marker text formatting does not appear to be evenly applied in the 
editable marker list. The current format state check marked in the IXgen 
menu does not match some of the formatted entries.

Solution: You possibly had a text selection in effect when using either Show 
Marker Char Tags Applied or Show Marker Char Tags as Text Cmds. 
The action of those commands would have been limited to the selected 
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text. (Review Operational Scope of IXgen Tools on page 23.) Or, you 
may have either applied a format by hand or typed in a text-based font 
command.

Do a single click to clear all text selections in the current editable marker 
list document. Then, based on which form you want to see, select either 
Show Marker Char Tags Applied or Show Marker Char Tags as Text 
Cmds again. (You can reselect one of the Show Marker tools, even if the 
check mark is already positioned at that command.)

Problem 20: IXgen does not appear on the main FrameMaker menu bar

Solution: You perhaps downloaded IXgen and placed the files where you thought 
they should go, but you did not run the setup.exe installer, or you ran 
the installer while logged in as administrator but now are running 
FrameMaker as regular user.

Rerun setup.exe. If this does not work, follow along with the steps given 
in Appendix A: Installing IXgen By Hand on page 99, and see if you can 
determine where the installation failed.

Problem 21: Special characters have been replaced by question marks

Solution: You have used an IXgen function on some or all of a FrameMaker 10 
document that included Unicode characters. IXgen does not support 
Unicode characters, and a new method of Unicode representation within 
FrameMaker 10 causes IXgen to damage those characters by converting 
them to question mark chracters.

At this time, the only solution is to retype the special character (or 
restore the damaged text from a back-up), and then not use IXgen on 
those portions of your FM10 document. 

For more information review Damage to Unicode Characters in 
FrameMaker 10 (and newer) starting on page 15.

This problem only applies to FrameMaker 10 documents and books.
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Five Year Warranty

This product will perform the functions described in this manual. However, should you 
have a demonstrable problem with the product we will investigate the problem with you. 
We might ask for copies of the file(s) that caused the problem, along with a brief statement 
from you describing the problem. Within 5 working days of receipt of your files we will 
verify the problem. We will then, at our discretion, do one of the following: (a) 
immediately issue you a new release of the product (no charge); (b) refund your purchase 
price (you must return the materials); (c) resolve the problem within 60 calendar days and 
issue you a revised version at NO CHARGE.

THE WARRANTIES DESCRIBED ABOVE ARE THE EXCLUSIVE FRANK STEARNS 
ASSOCIATES WARRANTIES AND ARE IN LIEU OF ALL OTHER WARRANTIES, 
EXPRESS OR IMPLIED, INCLUDING ANY WARRANTY OF MERCHANTABILITY OR 
FITNESS FOR A PARTICULAR PURPOSE OR ANY WARRANTY PREVIOUSLY 
ISSUED. FRANK STEARNS ASSOCIATES NEITHER ASSUMES NOR AUTHORIZES 
ANY OTHER PERSON TO ASSUME FOR IT ANY OTHER LIABILITY IN 
CONNECTION WITH THE SALE OR USE OF ITS PRODUCTS.

NO WARRANTY OF ANY KIND IS MADE OR SHALL BE IMPOSED WITH RESPECT 
TO ANY PRODUCT, THAT IN FRANK STEARNS ASSOCIATES SOLE AND 
ABSOLUTE JUDGMENT: (1) HAS NOT BEEN PROPERLY INSTALLED (2) HAS BEEN 
MODIFIED IN A WAY THAT AFFECTS PERFORMANCE OR RELIABILITY. CODE 
ALTERATION WHICH WAS NOT SPECIFIED BY FRANK STEARNS ASSOCIATES 
VOIDS THIS LIMITED WARRANTY.

THE PARTIES AGREE THAT THE BUYER’S SOLE AND EXCLUSIVE REMEDY 
AGAINST FRANK STEARNS ASSOCIATES SHALL BE FOR THE REPAIR OR 
REPLACEMENT OF DEFECTIVE CODE, OR A REFUND OF THE PURCHASE PRICE. 
THE REMEDY CHOSEN IS THE SOLE DISCRETION OF FRANK STEARNS 
ASSOCIATES. THE BUYER AGREES THAT NO OTHER REMEDY OR DAMAGES, 
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Five Year Warranty
INCLUDING BUT NOT LIMITED TO INCIDENTAL OR CONSEQUENTIAL 
DAMAGES FOR LOST PROFITS, LOST SALES, LOSS OF USE, INJURY TO PERSON 
OR PROPERTY, OR ANY OTHER INCIDENTAL OR CONSEQUENTIAL LOSS, SHALL 
BE AVAILABLE TO IT.

THIS WARRANTY IS IN EFFECT FOR AS LONG AS THE PROPER VERSION(S) OF 
FRAMEMAKER IS IN USE WITH THIS PRODUCT. THIS WARRANTY WILL BE 
EXTENDED TO LATER VERSIONS OF FRAMEMAKER ONCE FRANK STEARNS 
ASSOCIATES HAS TESTED THE PRODUCT WITH THOSE LATER VERSIONS. AN 
UPGRADE FEE MAY BE CHARGED.

THE TERM OF THIS WARRANTY IS FIVE YEARS FROM DATE OF PURCHASE.
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Appendix A: Installing IXgen 
By Hand

Introduction
Installing IXgen should be a simple task using the setup.exe install script provided 
with your IXgen distribution. However, occasionally something might go awry and 
installing IXgen by hand will be the quickest way to gain product access; or, you’ll want 
to check for yourself how IXgen was installed.
Using IXgen with the structured FrameMaker interface is overviewed in IXgen with 
Structured FrameMaker starting on page 102.

CAUTION: If you are using FrameMaker 10 or later and your book or document(s) 
contain(s) unicode characters (characters represented by two or more bytes), 
do not use any IXgen functions in that book or document. For more 
information see Damage to Unicode Characters in FrameMaker 10 (and 
newer) starting on page 15.

Installing by Hand
Briefly, installing IXgen by hand involves modifying the maker.ini file, creating a few 
new folders in your FrameMaker installation, and moving IXgen files to those new 
folders.
Here are the manual installation steps in detail.

1. If you haven’t done so already, create a scratch folder on your system where you 
can place the IXgen distribution files. If FrameMaker is currently running, close 
FrameMaker, Do not simply minimize FrameMaker, quit the application.

2. Go to http://www.fsatools.com and click on “Downloads” or “IXgen 
Central”. Download the appropriate IXgen distribution into a empty, scratch 
folder.
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Installing by Hand Appendix A
3. Double-click on the downloaded file to activate the self-extracting ZIP file. You 
now have the opportunity to run setup.exe again if you wish. But answer “N” 
if you know you wish to proceed with this manual installation.

4. In the order listed, create these new folders for IXgen. Use Windows Explorer 
or a command line interface to create these new folders. Be sure to use the 
names in typewriter font exactly as shown:

Go to this folder... and create this new folder

<FM_install_folder> ixgen

<FM_install_folder>\ixgen bin

<FM_install_folder>\ixgen templates

NOTE: Replace “<FM_install_folder>” with the location of your 
FrameMaker installation.  

Move the distribution files to the appropriate folders as shown in this folder 
map:

<FrameMaker Installation Folder>

ixgen

bin templates

ixgen.ini
removeix.exe

ixgen.dll
editable_list_ops.exe

bkctrl.fm
edtblist.fm
keyctrl.fm
permctrl.fm
valrefctrl.fm
valreport.fm
report.fm

5. Place ixgen7doc.pdf and demoixgn.pdf wherever you would like. If you 
have multiple versions of FrameMaker installed, make sure you’re creating 
folders and copying the IXgen files in the correct FrameMaker installation 
directory!

6. Edit the <FM_install_folder>\maker.ini file so that IXgen is registered 
as an API client with FrameMaker. Do this by adding the line of text noted just 
after the next paragraph. Wordpad, Notepad, or any other text editor (or word 
processor that can save a file unformatted as plain ASCII text) can be used.  
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Once maker.ini is loaded in the editor, search for the [APICLIENTS] 
section. Create a new line at the end of the existing block of API clients listed. 
(Typically, the last entry starts with “filters\ImportUtility.dll” but 
this may not always be the case.) In the new, empty line, enter this registration 
line exactly as shown here:

IXgen=Standard,Marker Management,ixgen\bin\ixgen.dll, all  
 
If your display shows the above line split over two lines, do not place a line 
break. Enter the text on one line.

7. Restart FrameMaker. If IXgen has loaded properly, you will see “IXgen” in the 
menu bar for FrameMaker.

Select IXgen>License. Here you will see the status of your IXgen license. If 
unlicensed, email us the key information as requested in the lower half of the 
dialog box. We will return a password to you.

If any of the requested information is missing from the body of your message, 
your request may be delayed or missed entirely. (This information is not used 
for marketing purposes, nor is the information shared with others.)

When you obtain your IXgen password, again select IXgen>License. Enter the 
new password in the “Current Password” text box. Click “Update Password”. 
You need not stop and restart FrameMaker to enter a new password. 

8. If you have added or changed fonts or are using an exotic printer, we suggest 
using FrameMaker to open each IXgen template file. These are *.fm files in the 
<FM_install_folder>\ixgen\templates folder. Allow FrameMaker to 
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IXgen with Structured FrameMaker Appendix A
make font substitutions (if any), then resave each template document. Be sure to 
use the original file name. Change nothing else in these documents at this time.

IXgen with Structured FrameMaker
IXgen is not “officially” supported for use with Structured FrameMaker, but we do have 
a number of people successfully using this combination. And we will honor our product 
warranty if you can successfully use IXgen with structured FrameMaker.
NOTE: IXgen can only work directly with markers. Any marker-related structure is not 
used, created, nor modified. Only markers themselves are manipulated by IXgen. In 
addition, structured markers will not be visible to IXgen.
Structured and non-structured versions of FrameMaker share a common executable. This 
means that only a single IXgen installation is required.
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Appendix B: IXgen Installation 
Pages from www.fsatools.com 

Introduction
The recommended documentation source for downloading, install, and licensing IXgen is 
the “IXgen Central” page of http://www.fsatools.com.

If you are working in a secured environment, or for the moment do not have access to the 
internet, refer to the pages in this appendix for detailed IXgen installation information. 
They are reproductions from the “IXgen Central” portion of the 
http://www.fsatools.com website.

At some point, however, you will need internet access to (a) download the required 
distributions and (b) communicate your registration information to us and (c) receive the 
IXgen password that will be emailed back to you.

These are the basic steps to get IXgen up and running:

1. Downloading

2. Installing

3. Licensing

4. Inputting the IXgen password.

Each step is described below.

Step 1. Downloads
1. Select your downloads from the list below. Don’t forget the IXgen Users Guide. 

Remember: the demo version of IXgen is the FULL VERSION. Our demos are 
fully functional; no need to worry about a re-installation after purchase or a 
special version of IXgen for demo purposes. (The duration of the IXgen 
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password determines the status of your IXgen installation.)  
 
Use whatever method is appropriate for your browser to download and save 
items. For example, Firefox and other browsers provide a save menu if you 
right-click on the link. (And, also, in Firefox, you might need to use the “Save 
Link As” option.) It’s generally best to save your IXgen downloads to a new, 
empty folder created specifically for IXgen. Avoid using the desktop or other 
general download locations.  
 
NOTE: IXgen is not offered for the Mac. 
 
(Internet access will be required for these downloads. Go to the “IXgen Central” 
portion of http://www.fsatools.com.)  

• IXgen Users Guide Covers IXgen 7 (for FrameMaker versions 7, 8 and 9) as 
well as IXgen 7-10 (for FrameMaker versions 10 and 
newer). File IXGEN7DOC.PDF will appear in your 
download folder. 

Then, download the following IXgen version(s) that matches the FrameMaker 
version(s) you’re using. You can have multiple IXgen and FrameMaker versions 
installed on the same system. (The Windows version, including whether 32 or 64 
bit, does not matter for this group of IXgen offerings.)

• IXgen 7-10 (Windows) Use with FrameMaker versions 10, 11, 12, and newer. 
File IX710win.EXE will appear in your download folder. 
(This is a self-extracting ZIP file.) 

• IXgen 7-10 Plain Zip Same as immediately above, but this is a zip file that you 
will manually extract. Use this version if your security 
settings will not permit execution of a self-extracting zip.

• IXgen 7 (Windows) Use with FrameMaker versions 7, 8 and 9. File 
IX72WN32.EXE will appear in your download folder.

• IXgen 5.5 (Windows) Legacy version for FrameMaker versions 5.5 and 6.0. 
Support is limited for this version, but we will still 
license this version if you are using these very old 
versions of FrameMaker. File IX72FM55.EXE will appear 
in your download folder

Step 2: Installing IXgen
The IXgen installation is very compact and has far less impact on your system than most 
applications and plug-ins. Follow these simple steps to install IXgen.
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Step 2: Installing IXgen
1. If currently running, shut down FrameMaker.

2. Bring up Windows Explorer and navigate to the dedicated folder where your 
IXgen downloads are stored.

3. Right-click on the IXgen distribution .exe file that you downloaded. Select “Run 
as Administrator.” This will start the self-extracting zip. If your security settings 
do not allow running a self-extracting zip, download and  manually extract 
ix710win.zip. Don’t attempt to run the IXgen installation from inside a zip 
folder. Always select “extract all” from Windows Explorer before attempting to 
install IXgen.

4. Once the extraction has completed, right-click on setup.exe and select “Run as 
Administrator.” Review the information presented by the installer; mostly this 
text is for your general information.  If you have more than one version of 
FrameMaker installed, select which version should receive IXgen when 
prompted. Otherwise, most users will be able to simply press Enter at each 
prompt and continue through the installation using the defaults provided.

That’s it for the installation process. But don’t restart FrameMaker just yet. Review the 
Licensing section first.

Example Installation Screens 

The opening screen advises of the 
somewhat different appearance of 
this installer, and why we chose 
this approach.

Press enter to continue.
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The installer searches for a current 
installation of FrameMaker. If no 
FrameMaker installations are 
present, setup will halt. If more 
than one FrameMaker is detected, 
you’ll be given a selection list and 
asked to decide which 
FrameMaker on this system should 
receive IXgen during this 
installation.

Press enter to continue.

The User Profile facility added 
sometime back is discussed. No 
IXgen users that we know of have 
made use of this facility. And, 
when introduced, bugs were 
present. If you do wish to use this 
facility, follow the directions in 
this screen to move the API Client 
registration line to the maker.ini 
file in the desired profile. Do this 
after the IXgen installation has 
completed.

Press enter to continue.

The installer is now copying files 
from the download folder and into 
their new home within the IXgen 
installation folders that reside in 
the main FrameMaker folder. In 
this particular installation, a 
previous run of the installer was 
detected by the presence of a 
backup copy of ixgen.ini. This 
backup copy will be overwritten 
unless you wish to save it 
(extremely rare that you’d want or 
need to do so).

Press enter to continue.
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Step 3: Licensing IXgen
Once you’ve installed IXgen, you’re now ready to receive a password from us that will 
activate your IXgen license.

To get your IXgen password, please email us (franks@fsatools.com). Please put “IXgen” 
in the subject line. In the body of the message, include these items:

• Your name

• Company name, if applicable

• Your email address, if different from what might appear in the reply-to field of 
your email to us (you’d be surprised how often that happens)

• Your telephone number (rarely, if ever, used)

• Your general status: full-time company employee or contractor. And if a 
contractor, indicate whether you’re using your own system or the company’s

The last few files are copied. You 
are reminded to download the 
IXgen Users Guide if you haven’t 
already done so. Also, take a look 
at the ixgndemo.pdf (yes, this is 
the correct name). This provides a 
guided demonstration of various 
IXgen features.

The IXgen installation has 
completed without errors.

Press enter to continue.

General licensing information is 
included here, but the presentation 
of this information is limited by 
this format. 

It’s best to follow along in the 
“Licensing” section of the IXgen 
Central page of this website.

Be sure to press enter to exit the 
installer. If you don’t, some 
“housekeeping” needed for the 
IXgen installation might not be 
properly completed.
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(NONE of this information is shared with or sold to others. See our Privacy Policy for 
more information.)

MOST IMPORTANTLY, WE NEED THE IXGEN SYSTEM KEY FROM YOUR IXGEN 
INSTALLATION.

Here’s how to get the IXgen System Key:

1. Using Windows Explorer, browse to where FrameMaker is installed (if you have 
more than one FrameMaker installed, go to the installation that you selected to 
host IXgen during the installation process).

2. Right-click on framemaker.exe and select “Run as Administrator. (Remember, 
you exited FrameMaker to do the IXgen installation, and now it’s time to restart 
FrameMaker.)

3. Once FrameMaker has started, you should now see “IXgen” as a new item in the 
main menu bar. Select “License…” from the IXgen drop-down menu. Don’t see 
“IXgen” in the main menu bar? Check here…

4. Near the top of the IXgen License dialog box, you’ll see a text box field titled 
“System Key”. Drag through the entire string in the box to select it, then copy 
(control-C) and paste it (control-V) into the email that you started above. Send 
that off to us and we’ll return a password. Installing the password is covered 
next.

Do you see “Error 67”, “Unavailable” or a blank system key field? You probably didn’t 
start FrameMaker by “Running as Administrator”. This is very important, please try again.

Example IXgen Licensing Screens
Here are a few sample screen captures of what you will usually see when accessing the 
IXgen>License Dialog box. Your screens will vary slightly, based on information specific 
to your machine and the version of IXgen you have installed. (We assume you’ve restarted 
FrameMaker, running as “Administrator”.)

Here is a typical initial IXgen>License dialog box:
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Next, select the text string in the “System Key” field, as shown in the next image. (To 
make the selection, click and hold at one end and drag to the opposite end. Be sure you 
have all the contents of the field selected. Then press Control-C to copy the string on the 
clipboard.)

Next, bring up your favorite email program and send us your name, email address (if 
different from the “reply-to” field of your email message), and your status as either a 
regular employee or contractor. Finally use control-V to paste the IXgen system key string 
into that message to us. We will return a password email.
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Step 4: Installing the IXgen Password

Within a very short time of receiving your IXgen password request (typically 4 business 
hours or less, but not more than 8 business hours), we will send you a password email. 
Haven’t received it? Double check your spam folder. Still not there? Feel free to resend 
your password request or give us a voice call at 1-435-275-8981 (we’re in Mountain Time 
of the USA). We understand that sometimes people need to get IXgen running 
immediately, and will do our best to accommodate that need.

The typical IXgen password email will list the contact information you sent us. (Please 
do send us corrections for any errors you see in that information.

Following that, you’ll see the line “PASSWORD”, and immediately below that a 12-digit 
hex number, grouped in three fields of four digits, separate by hypens. Here’s how to 
install your password:

1. Drag through the password string in your password email, then copy it 
(control -C) to the clipboard.

2. If FrameMaker is not running, restart it, “running as administator”, just as you 
did when acquiring the system key. If FrameMaker is running but was not started 
by “running as administrator,” close and restart FrameMaker, again by 
right-clicking on framemaker.exe and “running as administrator

3. Select “License…” from the IXgen drop-down menu.

4. Go to the “Current Password” field, click at the end of the field and back-space 
to clear out the entire contents of the Current Password field. Or, simply select 
the entire password string in preparation for a paste overwrite.

5. Paste the new password (control-V) into the Current Password field.

6. Click the “Update Password” button. Before dismissing the dialog box, review 
the “License Status”, second line down from the top of the dialog box. This 
should now read “Password is Valid”. If not, please see Troubleshooting. 
Curious about the password expiration date? See the FAQ question regarding 
password classifications.

7. Click “Done”. Congratulations! You’re not ready to being using IXgen. If you’re 
new to IXgen, we suggest a walk through the IXgen Users Guide. If you’re in a 
hurry, take a look at the “Cookbook” chapter. You’ll get some good ideas for 
what you can do with IXgen. There’s also a guided demo that came with your 
IXgen distribution entitled “demoixgn.pdf”.

Example Password Input Screens

Restart FrameMaker, once again running as Administrator. In the password email we sent 
to you, select the password string. Use control-C to copy the password onto the clipboard.  
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Step 4: Installing the IXgen Password
Next, again access the IXgen>License Dialog box.  Select the string in the “Current 
Password” field, as shown here:

1. Rress control-V to paste and over-write the “placeholder” password of 
AAAA-2222-CCCC with the real password we’ve sent to you.

2. Click Update Password.

1. Control-V (paste) 2. Click

3. New status indicated

3. Check the “License Status”. The password should be valid.

You are now ready to use IXgen. Review other portions of this manual. For several 
practical and “getting started” ideas, reveiw Suggested IXgen Uses (Cookbook) starting on 
page 78.
160301 IXgen 7 & 7-10 (for FrameMaker 7 through 15) www.fsatools.com 111

www.fsatools.com
www.fsatools.com


Index

Symbols

? (question mark) character appears 15

A

added or modified character tag formats 41
adding marker text directly

through expand/collapse markers 64
through the editable marker list 36

APICLIENTS 16,  101
append single second-level entries to the root 

entry 48
apply edited marker list 37
applying formatting, editable marker list 50
assumptions and set-up notes 11
avoiding nonsense rotations 39

B

backslash (“\”) 45
basic steps to install ixgen 103
batch nature of ixgen 25
book file, shadow (ixc file) 15
book-level index or marker list, maintaining 79
books

.ixc file 15
considerations for

Create Subentries 43
Elevate Unique Subentries 48
Validate References 49

IX document as source of character tags 52
IXgen functions with books 24
marker type conversions 80

bugs
editable marker list apply 33,  91
See also Problems

C

capitalization
formatting issues 55
unification in marker text 58

catalog, save character 41
categories of ixgen tools 26
changing the fonts used by IXgen 17
character catalog

copying to template 57
saving 41

character formats
creating new formats in the marker list 55
formatting process 52
sources for formatting 52
used in markers 50

character tag formats, added or modified 41
character tags

IXgenMarker 61
markers from 74
shown as applied formatting 50
shown as embedded format commands 56
<Tagname> 56

characters in FrameMaker 10 (and later 
versions), damage to Unicode 15

characters, literal values
in Markers from Character Tags 75
in Markers from Keywords 67
in Markers from Paragraph Tags 73

characters, maximum allowed (marker length 
limit) 46

check marks in the ixgen main menu format 55
checking references, see Validate References
Collapse Markers 63
common root entry, placing entries under 43
concordance vs. index 22
configuration

disk usage 11
IXgen 11
system 11
tools (when invoked) 19

conflicts with the marker window 26
console window

error reporting 18
operating system interaction 16
process status 25

control capitalization standards 58
control lists (for permute marker) 40
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Index
convert applied character formats 56
converting from one marker type to another 79
cookbook 78
Copy Char Catalog to Template 57
Create Subentries 43
creating new character formats in the marker 

list 55
customizing

Editable Marker List template formats 55
Flip reference options 45
FlipFirstSeparator (Flip Entries) 45
fonts used by IXgen 17
Markers from Keywords 65
operational scope of IXgen 23
permute operations 39
templates 17
Validate References 49

D

damage to unicode characters in FrameMaker 
10 15

delete a marker 34
deleting

all markers 81
redundant markers 77

demoixgn 14,  17
Descriptions

explanation of IXgen tools
descriptions

documentation format 32
explanation of IXgen tools 32
see also Tools

directly adding marker text
through expand/collapse markers 64
through the editable marker list 36

disk usage 11
display fonts vs. production fonts 53
document layout (PDF information) 10
downloads 11
duplicate markers, deleting 77

E

Editable Marker List
apply changes 37
apply formatting 50
capitalization controls 58
Create Subentries 43
creating new character formats 55

Elevate Unique Subentries 48
Flip Entries 44
generating 33
Permute function 39
Speed Flip 47
Split function 38
template document (edtblist.fm)

changing appearance 36
changing fonts 17
updating character tags 57

text-based character formatting 56
Validate References 49

edtblist.fm 17,  36,  57
Elevate Unique Subentries 48
entries

append single second-level entry to the root 
entry 48

creating, see Tools
Flip 44
under a common root entry 43

errors
during startup 18
during use 18
font 17
Generate Editable Marker List fails 94
invalid references 49
Problems and Solutions 85,  86,  89
reporting 18
See also Problems

exchange, copy, or make references 44
Expand Markers 61

placeholder text 
(!IXGEN_DONT_EDIT_THIS!) 61

See also Collapse Markers
explanation of IXgen tool description 

format 32

F

file menu, using IXgen functions through the 
book 24

file relevance, generated files 24
Files

.ixc 15
ixgenkey.999 11
maker.ini

multiple IXgen installations 16
shadow book 15

files
installation illustration 100
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ixgen.ini
FlipFirstSeparator 45
MFKMaxHistory 66

maker.ini
editing for installation 100

See also Problems, Templates
flip

action 45
entries 44
reference options 45
type 45

FlipFirstSeparator, changing 
parameters 45

floating menu (toolbar) 33
FM10 (and later versions), damage to unicode 

characters 15
fonts

display vs. production in marker list 
formatting 53

used by IXgen 17
format

check mark indicators in the IXgen main 
menu 55

command syntax (<tagname>) 56
format, description of IXgen tool 

documentation 32
formats (character) in the marker list, creating 

new 55
formats, added or modified character 

tagging 41
formatting

character formatting in markers 50
editable marker list 50
process and sources of character formats 52

FrameMaker 10 (and later versions), damage to 
unicode characters 15

framemaker, structured 102
<FM_install_folder> 100
<FM_install_folder>\ixgen\
templates\edtblist.fm 57

functions through the book file 24

G

Generate Editable Marker List or other IXgen 
function fails 94

Generate Editable Marker List, Tools, See 
Tools

generated file relevance 24

generating an editable marker list (figure) 34
generating markers from keywords (figure) 66

H

handling the 255 character marker length 
limit 46

highlighting, see Operational Scope of 
IXgen 23

I

index or marker list, maintaining a book-
level 79

index vs. concordance 22
insets, text 15
installation items

manual installations 99
removal 13
Structured and Unstructured 

FrameMaker 102
installation quick start 12
installation, basic steps 103
installing

IXgen 11
passwords 11

interaction with
document files 14
FrameMaker console window 16
sort override 46
text insets 15
Windows print system 17

inverting see flip 44
.ixc

IXgen shadow book file 15
trick to select many files 25

IXgen
batch nature 25
book file, see Books
console window 16
demo file 14
fonts 17
function summary (table) 27
installation folders 100
licensing 11
main menu format check marks 55
sequence of tool use 31
tool description format, explanation of 32
tools, scope of 23,  38
tour 14
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Index
uses 78
ixgen

errors 85
Problems and Solutions 85
tool categories 26

IXgen Tools that Rely on Book Processing 24
ixgen.ini

FlipFirstSeparator 45
MFKMaxHistory 66

ixgen.ini, see Files
ixgen.ixc file 15
!ixgen_don’t_edit_this!” appears in index 92
IXgenMarker 61,  63

K

keyctrl.fm
configuration introduction 65
configuration notes 70
hypertext example 82
keywords from existing index example 80
using as a template document 82

keywords, markers from 65

L

length limit, handling the 255 character 
boundary 46

licensing 11
licensing IXgen

general notes 11
ixgenkey.999 file 11

limit, handling the 255 character length limit 
for markers 46

list of marker types (table) 20
list, marker, creating new character formats 55
literal values of special characters

in Markers from Character Tags 75
in Markers from Keywords 67
in Markers from Paragraph Tags 73

lost Unicode characters 15

M

main menu (IXgen) format check marks 55
maintaining a book-level index or marker 

list 79
maker.ini

editing for installation 100
multiple IXgen installations 16

see also Files
manual installation 99
Marker list, see Editable Marker List
marker text, adding directly

through expand/collapse markers 64
through the editable marker list 36

marker text, deleting 34
markers

character formatting 50
collapsing into markers from body text 61
control lists, permute (rotate) 40
converting type 79
deleting all 81
deleting redundant 77
elevating unique entries 48
expanding into body text 61
flipping index entries 44
length limit, handling the 255 boundary 46
Markers from...see the individual "Markers 

From" tools below
passthrough 14
text function, using permute (rotate) 39
type conversion 79
types (table) 20
validating references 49
window, conflicts with 26
editable list, see Editable Marker List

markers from
character tags 74
keywords 65
paragraph tags 72

menu changes 24
menu format check marks in the ixgen main 55
menu functions through the book file 24
menu, floating (toolbar) 33
MFKMaxHistory 66
modified character tag formats 41
modifying IXgen, see Customizing

N

nature of IXgen (batch operations) 25
new character formats in the marker list, 

creating 55
nonsense rotations, avoiding 39
<$nopage> command

making a keyword list 80
reference flip options 45
used with Permute Markers 39
used with Validate References 49
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Index
O

one marker type to another, converting 79
operational scope of IXgen 23
options, reference flip 45
order of ixgen tool use 31
override interaction (sorting) 46

P

<$pagenum> command 80
paragraph tags, markers from 72
passthrough markers 14
password installation, general notes 11
PDF and Document Layout 10
permctrl 40,  41
permctrl.fm 40
Permute (rotate) marker control lists 40
place entries under a common root entry 43
placeholder text 

(!IXGEN_DONT_EDIT_THIS!) 61
preserve character format changes 57
print system interaction 17
printing the IXgen Users Guide (PDF 

information) 10
problems

solutions to 85
summary (table) 86,  89

problems (installation)
An error has occurred that is beyond the 

scope of this manual 88
Files can’t be copied, executed, opened, or 

moved 87
IXgen seems to be installed, but the 

password field in the IXgen>License 
will not accept the password sent to 
us. 88

IXgen seems to be installed, but the status 
field in the IXgen>License dialog 
box shows “Error 14” after the 
password was input and “Update 
Password” was pressed 87

IXgen seems to be installed, but the system 
key field in IXgen>License dialog 
box shows “Error 67” 87

IXgen seems to be installed, but the system 
key field in the IXgen>License 
dialog box is empty or shows “not 
available”. 88

Nothing happens when clicking the self-
extracting zip file 86

The link for the IXgen download on the 
fsatools.com website appears 
inactive 86

problems (operations)
All the files in the book are open and 

minimized, but IXgen asks again for 
files to be opened 93

An editable index is created, but no 
markers are listed 89

Gen Editable Marker List is missing some 
markers 90

IXgen can’t create an editable index file 95
IXgen does not appear on the main 

FrameMaker menu bar 96
!IXGEN_DON’T_EDIT_THIS!’ appears in 

index 92
Marker text formatting does not appear to 

be evenly applied 95
Marker text suddenly appears in cross 

references 92
Some or all of the changes made in a Gen 

Editable Marker List file did not get 
transferred back to the source 
document(s) 91

Too many Gen Editable Marker List files, 
and none of the files are named! 90

Various Template documents are too large 
for the display 92

problems and solutions
Special characters have been replaced by 

question marks 96
processing generated files (relevance) 24
production fonts vs. display fonts 53

Q

question mark character appears 15
question mark character replacements 15
quick start, installation 12

R

redundant markers, deleting 77
reference flip options 45
reference page use 14
references, checking for valid 49
relevance of generated files 24
requirements (system) 11
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root entry
append single second-level entries 48
place entries under a common root 43

rotations, avoiding nonsense 39
runtime status 31

S

save character catalog 41
scope of ixgen tools

general notes 23
limiting the Apply operation 38

second-level entries to the root entry, append 
single 48

selecting text to limit ixgen activity 23
See also Scope

sequence of ixgen tool use 31
set-up notes, assumptions 11
shadow book (ixc) file 15
show marker char tags

Applied 50
as Text Cmds 56

show marker text character formatting 50
single second-level entries to the root entry, 

append 48
sort override interaction 46
sources of character formats 52
special character tag

IXgenMarker 61
UncataloguedCharTagTemplate 53

special characters, literal values of 67,  73,  75
speed flip 47
split function, using 38
status, runtime 31
structured framemaker 102
structured framemaker, installing ixgen 

with 102
subentries

creating 43
elevating unique 48

suggested ixgen uses 78
system

interaction 16
requirements 11

T

tagged formats, character, added or 
modified 41

tags
copying to edtblist.fm template 57
markers from character 74
markers from paragraph 72
see also Character Tags

templates
customizing 17
edtblist.fm, copy char catalog to 57
installation illustration 100
\ixgen\templates 40
keyctrl.fm 66
list of template files

for changing fonts 95
for resizing 93

permctrl.fm 40
text function, using permute (rotate) marker 39
text insets 15
text selections, using 23
text-based embedded character format 

command syntax <tagname> 56
toolbar, accessing 33
tools

Apply Edited Marker List 37
categories 26
Collapse Markers 63
Copy Char Catalog to Template 57
Create Subentries 43
Delete Redundant Markers 77
descriptions of tools (documentation 

format explained) 32
Elevate Unique Subentries 48
Expand Markers 61
Flip Entries 44
Gen Editable Marker List 33
Markers from Character Tags 74
Markers from Keywords 65
Markers from Paragraph Tags 72
Permute (Rotate) Marker Text 39
scope of tools 23
sequence of use 31
Show Marker Char Tags Applied 50
Show Marker Char Tags as Text Cmds 56
Speed Flip 47
Split 38
toolbar, accessing 33
Validate references 49

type conversion, marker 79
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U

UncataloguedCharTagTemplate 
format 53

under a common root entry, place entries 43
Unicode characters in FrameMaker 10 (and 

later versions), damage to 15
unique subentries, elevate 48
usage, disk 11
Users Guide, printing (PDF information) 10
using IXgen

see also Tools
usage suggestions 78

with the marker window 26

V

Validate References 49
values of special characters 67,  73,  75

W

why index 21
window, conflicts with the marker 26
Windows print system (interaction) 17
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